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Documentation Updates

The title page of this document contains the following identifying information:

¢ Software Version number, which indicates the software version.

o Document Release Date, which changes each time the document is updated.

o Software Release Date, which indicates the release date of this version of the software.

To check for recent updates or to verify that you are using the most recent edition of a document, go
to:

http://h20230.www2.hp.com/selfsolve/manuals

This site requires that you register for an HP Passport and sign in. To register for an HP Passport
ID, goto:

http://h20229.www2.hp.com/passport-registration.htmi
Or click the New users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product support
service. Contact your HP sales representative for details.
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Support

Visit the HP Software Support Online web site at:
http://www.hp.com/go/hpsoftwaresupport

This web site provides contact information and details about the products, services, and support
that HP Software offers.

HP Software online support provides customer self-solve capabilities. It provides a fast and
efficient way to access interactive technical support tools needed to manage your business. As a
valued support customer, you can benefit by using the support web site to:

o Search for knowledge documents of interest

o Submit and track support cases and enhancement requests
o Download software patches

« Manage support contracts

e Look up HP support contacts

¢ Review information about available services

¢ Enterinto discussions with other software customers

o Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also
require a support contract. To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.htmi
To find more information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp
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Disclaimer for PDF Version of Online Help

This document is a PDF version of the online help. This PDF file is provided so you can easily print
multiple topics from the help information or read the online help in PDF format.

Note: Some topics do not convert properly to PDF, causing format problems. Some elements of
online help are completely removed from the PDF version. Those problem topics can be
successfully printed from within the online help.
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Chapter 1

Financial Planning and Analysis

Financial Planning and Analysis (FPA) helps organizations make better IT financial decisions by
reducing the effort involved with managing IT finance and giving business the financial
transparency it demands. FPA does this by consolidating and allocating planned and actual costs
from HP Asset Manager and HP Project and Portfolio Management, and alternate data sources.

With pre-built data integration, data cleansing, and a central repository for cost information, FPA
helps organizations significantly reduce the effort involved in transforming cost and budget data into
easy to understand cost information. It provides information in a meaningful way to business,
accounting, and IT management stakeholders with pre-built reports and ad hoc analysis. FPA
supports financial management process improvement by providing unprecedented visibility into
process effectiveness and efficiency.

FPA accelerates time to value by providing a complete business intelligence platform. ITIL-based
analytics and dashboards show process and financial performance trends. FPA augments this
platform with an allocation engine for planned and actual costs, a rules engine to calculate monetary
business impact of incidents and changes, and an optimization engine to simulate changes to
factors under IT’s control.

Features

The complete Financial Planning and Analysis package contains different applications that enable
management to perform advanced analyses using data extracted from HP applications. Financial
Planning and Analysis uses an integrated version of SAP® BusinessObjects Enterprise Xl to
complete the ETL processes and format out-of-box and ad hoc analytics. The following table
summarizes Financial Planning and Analysis features in this release.

Feature Description

Financial Application that provides your IT stakeholders with actionable cost information
Planning and | that supports effective cost containment and investment decisions. It includes
Analysis IT cost consolidation, IT cost allocation, allocation scenarios, budgeting, IT cost
(FPA) dashboards, Cost Explorer, analytics, and integration with HP Asset Manager,

HP Project and Portfolio Management, and alternate source data in Microsoft
Excel spreadsheets.

Data Imports historical incident, project, and financial data into the data warehouse to
populate scenarios and analytics. The data warehouse stores data that
originates in disparate external applications but undergoes transformation when
extracted and consolidated using a newly designed extract, transform, and load
(ETL) process managed by the data warehouse.

Application Applications run in a single framework with a single navigation pane that
infrastructure | accesses different components, out-of-box analytics, and SAP® Business
Objects Enterprise Xl in an integrated environment.
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Financial Planning and Analysis architecture

The Financial Planning and Analysis internal components enable you to define data driven
scenarios that predict the result of business decisions. It depends on SAP® Business Objects,
which is an enterprise business intelligence solution that interacts directly with Financial Planning
and Analysis to summarize data in reports or display it in management dashboards.

SAP® BusinessObjects Data Services is the ETL tool that extracts data from your data sources to
populate the data warehouse.

Financial Planning & SAP
Analysis and SAP BusinessObjects SAP
Alternate Source BusinessObjects e C

BusinessObjects
spreadsheets Web Tier Server Repository

Data
ETL Process Warehouse

Page 12 of 100 HP Financial Planning and Analysis (9.20)



Chapter 2

What's new?

HP Financial Planning and Analysis is an integrated part of the HP ClO Solutions portfolio.
Financial Planning and Analysis 9.20 is a minor release that contains new features and
enhancements. Read the topics in this section to learn more about:

o "IT Executive Scorecard and Financial Planning and Analysis portfolio compatibility" (on page
13)
o "Budgets" (on page 14)

o "Dashboards" (on page 14)

« "Installation and configuration" (on page 14)

o "Reports" (on page 14)

IT Executive Scorecard and Financial Planning and Analysis
portfolio compatibility

Addressing IT management's key challenges, HP's IT Executive Scorecard and Financial Planning
and Analysis portfolio helps customers cut IT costs, speed delivery of a new services, and align IT
for business value.

The data warehouse foundation is based on defined compliance policies to apply the compliance

rules for universes, target model, consolidation model and metadata model. You can install HP IT
Executive Scorecard and Financial Planning and Analysis on the data warehouse foundation and

share data between the products.

The Financial Planning and Analysis application relies on data from Asset Manager or Project and
Portfolio Management Financial Management (or both), as well as alternate source data that you
provide in Microsoft Excel spreadsheets to produce results. This version of Financial Planning and
Analysis adds compatibility with Project and Portfolio Management 9.10.

The HP Project and Portfolio Management Financial Management module generates data about
budgets. Extract, Transform, and Load (ETL) processes can extract this data, consolidate it with
similar data from other applications, and store it in the data warehouse. Project and Portfolio
Management Financial Management typically produces capital and operating planned and actual
cost data.

HP Asset Manager generates data about the physical, financial and contractual aspects of IT
assets. Extract, Transform, and Load (ETL) processes can extract this data, consolidate it with
similar data from other applications, and store it in the data warehouse. Asset Manager typically
captures inventory and configuration data about every device and the software installed on those
devices.

Page 13 of 100 HP Financial Planning and Analysis (9.20)



Application User Guide
Chapter 2: What's new?

Budgets

The budgeting tool is a component of Financial Planning and Analysis (FPA) that enables IT finance
managers to plan a budget for three different planning time frames: one, two, or three years. The
budget tool provides finance managers with these options:

¢ Define the budget configuration.

o Send notification to all or selected IT cost center managers.

o Enter budget data at the cost center level.

o Check the status of the review process for one or all IT cost centers.
+ Review graphical views of consolidated budgets.

o Publish budgets that populate the data warehouse with cost center plans.

Dashboards

This version of Financial Planning and Analysis enhances dashboard support with new
capabilities:

o Select year option
o Performance improvement

o Dirill through

Installation and configuration

The installation wizard guides you through the steps to install the Financial Planning and Analysis
components. The Installation and Configuration guide is interactive, enabling you to select options
that describe your configuration of FPA 9.20 and then view or print a customized guide that includes
only the requirements and tasks that apply to you.

To obtain the most current version of this guide, visit the product manuals web site at: HP Software
Product Manuals.

This site requires that you register as an HP Passport user and sign in. To register for an HP
Passport ID, go to: HP Passport Registration.

Reports

You can use the new Bill of IT analytic to view cost statement summary reports at the customer
level.

The analytic can help answer business questions such as these:

o What are the top 10 business services with the highest actual cost?

« What are the actual cost, planned cost, and variance from plan by business service?
o What percent of the actual cost is the business service consuming?

You can use the new Service Decomposition reports to view service cost decompositions by
configuration item and cost categories.
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The analytics can help answer business questions such as these:

« What are the top 10 configuration item types with the highest actual cost?

o What are the top 10 cost categories with the highest actual cost?

o What are the actual cost, planned cost, and variance from plan by configuration item?

o What is my average cost for computers across all business services and cost categories?

o What percent of my actual costs is for servers?
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Working With Financial Planning and Analysis

Financial Planning and Analysis (FPA) helps organizations make better IT financial decisions by
reducing the effort involved with managing IT finance and giving business the financial
transparency it demands. FPA does this by consolidating and allocating planned and actual costs
from your data sources to help IT manage those costs more effectively.

FPA has these benefits:
o It speeds analysis of cost drivers and variance to plan.

o It supports multi-dimensional analysis of planned and actual costs with a dedicated analytical
interface for IT Financial Analysts.

o It offers business-focused analytics that provide standard views of IT financial performance.
To start using FPA

First make sure that the application is installed and configured according to the directions in the
Financial Planning and Analysis Installation and Configuration Guide.

1. Log on to the application web server.
= Type the Financial Planning and Analysis URL in your browser. For example, type:
http://servername:portnumber/FPA/

= Type avalid Username and Password.
= Click Log in.

2. From the main menu bar, click one of these links:
= Allocations

= Budgeting
= Dashboards

Reports

What is Financial Planning and Analysis?

Financial Planning and Analysis (FPA) provides cost visibility for IT. Capable of supporting
numerous IT cost dimensions, FPA provides the informational needs of IT management,
accounting, and business leaders to help them make better investment and IT decisions and to look
for trends in IT cost drivers and budget variance.

FPA includes several ways to analyze the allocation results. For financial analysts, FPA offers a
streamlined interface called Cost Explorer that helps the analyst answer ad hoc questions quickly.
For business users and IT management, FPA offers out-of-box analytics that show important
financial data concerning entities such as organizations and business services. FPA also offers a
dashboard that helps users quickly identify IT financial areas that require attention.

The Financial Planning and Analysis component has these features:
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o IT cost consolidation: FPA allows your organization to consolidate planned and actual costs in
a single system. It gives IT the big picture as well as the detail it needs to more effectively
manage budget performance.

o IT cost allocation: With the FPA allocation engine, IT can distribute cost across multiple cost
models giving it the ability to analyze budget performance from many angles.

o Allocation scenarios: You can create multiple “what-if” allocation scenarios and use the results
to compare budget versions against actual costs and budget objectives.

« Budgeting: The FPA budgeting feature enables IT finance managers to plan a budget for three
different planning time frames: one, two, or three years.

o IT cost dashboard: The FPA Dashboard lets your IT executives view planned versus actual
performance for IT overall, by customer, by IT organization, by service, by program, and by
project. Your IT executives may also see the areas with the highest variance to help them focus
their management attention.

o Cost explorer: The FPA Cost Explorer allows your IT finance and cost analysts to
systematically explore cost variance by organization, business service, application, program,
project, cost center, and cost category, as well as other dimensions. By slicing and filtering data
across multiple dimensions, analysts can gain new insight into what is driving costs, where the
largest variance to plan is taking place, and why the variance might be happening.

o IT cost analytics: Through Web Intelligence analytics, users can see daily updates on planned
versus actual performance. Users can modify the out-of-box analytics as necessary to support
the specific cost analysis needs of their organization. Users can also perform ad hoc analysis of
cost data to answer less common questions while knowing that the data they are seeing is
consistent across all users.

o Integration with HP Asset Manager (AM) software, HP Project and Portfolio
Management (PPM) software: Out-of-box integrations with AM and PPM make gathering cost
data more efficient. Integration processes keep the data current.

Allocations

The allocation tool is a component of Financial Planning and Analysis (FPA) that enables you to
create scenarios that transform cost and budget data into meaningful cost information.

Assumptions

In Financial Planning and Analysis (FPA), allocations are based on predefined assumptions and the
business rules of your organization. Actual and planned cost allocations include these common
assumptions:

o The financial analyst needs access to the details related to the cost to properly understand the
semantics of the cost to be allocated. For example, if a cost is related to an asset, the analyst
needs access to the fields on that asset record to help determine the proper allocation. FPA
provides most of the needed information.

« Costs are not aggregated prior to allocation. Instead, costs are allocated at the lowest level of
granularity possible, using aggregation later in the process.

o Allocation rules are not used to generate transactions.
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o Costs are brought into the data warehouse in a local currency and an exchange rate converts the

local currency into a reference currency.

o Costs that span multiple dates should be broken down into smaller periods, at least monthly,

prior to allocation.

¢ The financial analyst allocates an actual cost for one of these reasons:
= Toenrich the cost by adding a 1:1 relationship to the cost, resulting in a 100% allocation.

or

= Todistribute the cost by splitting it across two or more relationships, resulting in a partial

allocation.

This table compares the assumption differences between actual cost allocation and planned cost

allocation.

Actual Cost Allocation Planned Cost Allocation

All actual costs are related to a cost
type/category.

Planned costs may be related to a budget.

The financial analyst wants to perform bulk
allocations rather than allocate each cost
individually. The best way is to specify criteria
that are used to select a set of costs and to
establish what kind of allocation to apply to that
set of costs.

The financial analyst wants to perform
individual allocations rather than allocate
costs in bulk.

This release of FPA explicitly supports a cash
flow view of costs.

Planned costs represent aggregated
estimates of future costs and the main
purpose of the allocation is to break down
those aggregates to the same level the
actual costs are aggregated through actual
cost allocation.

Actual costs are associated with a single date.
Using this date, the cost is associated with a
financial period.

Planned costs are associated with a financial
period.

Cost data model

The Financial Planning and Analysis cost data model is a star schema that consists of a Cost fact
table with related dimensions that include these relationships:

o Application

o Base Currency
o Budget

o Budget Line
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¢ Business Service
« Configltem

¢ Contract

o Cost Category

o Cost Center

e Customer

o Date (Local)

o Date (UTC)

o Discretionary Flag
o Fiscal Period

o IT Functional

¢ Incurred Person
e Local Currency
e Location

e Opex/Capex Flag
o Organization

e Program

o Project

e Supplier

When defining an allocation stage, you can distribute costs across your business model by these
relationships. Each dimension represents another business model or way to manage the costs.
This enriches the data in the Cost table.

During the Extract, Transform, and Load (ETL) process, SAP® BusinessObjects Data Services
(BODS) gathers the data for some entities from multiple source systems. BODS then consolidates
the data into a target data model before loading it into the target layer of the data warehouse.

For more information about target data models and ERDs, see the [ERDs on the manuals site].

For more information the ETL process, see the Financial Planning and Analysis ETL Reference
Guide. The most current version of this document is available on the product manuals web site at:
HP Software Product Manuals

This site requires that you register as an HP Passport user and sign in. To register for an HP
Passport ID, go to: HP Passport Registration.

Dashboards

The dashboards let you view actual versus planned performance for customers, IT organizations,
business services, and programs. To help focus management attention, you can also use
dashboards to view the customers, IT organizations, business services, programs, and cost
categories that have the highest positive variance.
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FPA data

When you install the Financial Planning and Analysis component, it uses data extracted from one or
more of these applications:

o HP Asset Manager
« HP Project and Portfolio Management
o Alternate source spreadsheets

The following diagram shows the data flows that FPA uses.

FPA
Working
Set

Allocation
Enging

Alternate Source
spreadsheets

Universe and
Analytic Views

The source data is regularly refreshed by data warehouse extract, transform, and load (ETL)
processes.

For more information about running ETL jobs and using data warehouse tools, see the Data
Warehouse Administration Guide. For more information about FPA data flows, see the Financial
Planning and Analysis ETL Reference Guide. The most current versions of these documents are
available on the product manuals web site at: HP Software Product Manuals

This site requires that you register as an HP Passport user and sign in. To register foran HP
Passport ID, go to: HP Passport Registration.

Prerequisites
Success depends on meeting these prerequisites:
o The data warehouse is installed and accessible.

o Your source database is Asset Manager, Project and Portfolio Management, Business Service
Management, Service Manager, or your own proprietary data.
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o You understand the assumptions for actual cost allocation and planned cost allocation.

¢ You define cost allocations using the cost data model.

Reports

You can use the out-of-box Web Intelligence (Webi) reports to view daily updates on actual versus
planned performance. You can modify the analytics as necessary to support the specific cost
analysis needs of your organization. You can also perform ad hoc analysis of cost data to answer
less common questions, while knowing that the data you view is consistent across all users.

Data extracted from Project and Portfolio Management and Asset Manager populates the Multiple
Dimensional Cost Comparison Analysis report.

For more information about using Webi reports, refer to the SAP® Business Objects
documentation available at the SAP Help Portal (http://help.sap.com) web site.

Security roles
A security role determines what you can do in Financial Planning and Analysis (FPA).

You need at least one of these roles to access FPA. If you have multiple roles, the one with the
most access rights has priority.

Role Allocations Budgeting Dashboards Reports Admin Tools

FPA_ADMIN Read-only | Read-only budget list, X X X X
view consolidated
budget

FPA_ANALYTIC Read-only budget list, X X X
view consolidated
budget

FPA_BUDGET_ X

COORDINATOR

FPA_CE_ Read-only X X X

CONFIG

FPA_COST_ X

CENTER_

MANAGER

DW_ADMIN X X

Contact your data warehouse administrator to change your access level. For more information
about the budgeting user roles, see "Budgeting workflow" (on page 41).
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Chapter 4

Allocations

The allocation tool is a component of Financial Planning and Analysis (FPA) that enables you to
create scenarios that transform cost and budget data into meaningful cost information. The
scenarios use data gathered from Asset Manager and Project and Portfolio Management.

To use allocations
1. From the main menu bar, click Allocations > Scenarios.

2. Select the scenario.

Cost allocation

Organizations need to know where they spend money and what areas are driving costs. Costs can
be viewed from different perspectives, such as by IT department or programs. Allocation enables
organizations to compare planned and actual costs by these perspectives to better manage the
business.

Cost allocation enriches the information by relating costs to areas that are meaningful to the
business. It distributes costs across the business model.

Planned cost model

Business model

Actual cost model

For example, a Financial Analyst wants to create views of planned vs. actual cost by IT
department, Program, and Application. These views are collected from asset management and
project management data source systems. The analyst can change the cost records by defining
rules through a series of steps. To manage the Allocation Rules, FPA groups rules into Allocation
Stages. These stages transform the original costs into an enriched set of costs.

« Within a defined stage, the analyst creates a rule statement to define cost allocation rules. The
first part of the rule statement, called source selection, involves defining the specific planned or
actual cost to be allocated.

o The next part of the rule statement, called the target selection, allocates the costs to a target
area. The analyst can allocate to single or multiple dimensions.
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o After the planned and actual stages and rules are defined, the Cost Explorer tool becomes
available. Cost Explorer provides a multi-dimensional cost analysis where the analyst can drill
down from summary views of planned and actual costs.

Allocation provides a way to analyze the cost data from different perspectives. By collecting the
right information, organizations can manage their costs better.

Budget allocation

Budget allocation enriches the information by relating budget costs to areas that are meaningful to
the business. It distributes costs across the business model.

For example, once a budget gets published to the allocation engine, a Financial Analyst wants to
want to break it down by the project, program, or business service. The analyst may create a rule
that says if the cost center is abc and the cost category is hardware, then evenly distribute costs
across selected business services. The analyst can change the cost records by defining rules
through a series of steps. To manage the Allocation Rules, FPA groups rules into Allocation
Stages. These stages transform the original budget costs into an enriched set of costs.

« Within a defined stage, the analyst creates a rule statement to define budget allocation rules.
The first part of the rule statement, called source selection, involves defining the specific budget
cost to be allocated.

o The next part of the rule statement, called the target selection, allocates the costs to a target
area. The analyst can allocate to single or multiple dimensions.

o After the planned and actual stages and rules are defined, the Cost Explorer tool becomes
available. Cost Explorer provides a multi-dimensional cost analysis where the analyst can drill
down from summary views of planned and actual costs.

Allocation provides a way to analyze the budget data from different perspectives. By collecting the
right information, organizations can manage their budgets better.

Metric based allocation

Costs can be allocated to targets equally, by a fixed percentage, or using metric based allocation.

Metric based allocation distributes costs dynamically with values that might change from period to
period. For example, an Organization's head count, the amount of disk space that a Project
consumes, or the number of service tickets logged by a Person.

Example

By using metric based allocation, a company can track the IT cost for maintaining an email
Business Service for an Organization over a specified period. The financial analyst considers these
factors:

¢ Everyone in the company uses an email service.

o People are grouped into Organizations.

¢ Organizational headcounts vary from period to period.

o IT provides email as one of its Business Services to all Organizations in the company.

o |T tracks the cost for maintaining this email service for each fiscal period (month).
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o IT wants to distribute costs for this Business Service across all organizations based on their
headcount.

The analyst defines the allocation scenario and date range. A stage in the scenario targets the
Organization. Within the stage, the analyst defines a rule to find all costs that are associated with
the email service and distribute the costs using the metric values of headcount.

Data for metric based allocation is available from a table that contains information based on a
combination of dimension name, metric name, and time period. For information about providing
valid data and using the table to load metrics based allocation, see the Financial Planning and
Analysis Data Warehouse Administration Guide

The most current version of this document is available on the product manuals web site at: HP_
Software Product Manuals

This site requires that you register as an HP Passport user and sign in. To register foran HP
Passport ID, go to: HP Passport Registration.

Allocation engine

The allocation engine is a process that communicates with the Financial Planning and Analysis
web application. It provides status information about your allocations when you make changes to
stages orrules. It selects costs, updates relationships, and splits costs across the data model.

By using allocation scenarios, stages, and rules, financial analysts can allocate the costs to
compare planned versus actual costs and use the results for proper cost and budget management.

1: Define allocation scenarios

An allocation scenario describes what planned and actual IT cost information you want to analyze.

Scenarios contain allocation stages, such as cost centers or organizations, to help you enhance the
cost information. You can further enrich the data with allocation rules that create new records
without changing the original data. The sequence of the allocation stages and allocation rules
determines how the allocation engine calculates the data.

Allocation scenario

An allocation scenario is a tool that enables you to analyze planned costs and actual costs by
categorizing them. You can use categorized costs to compare planned (budgeted) costs to the
actual costs.

As an organization collects cost information in asset management and project management
systems, those costs are related to areas that are meaningful to the business, such as projects or
organizations. The relationships established in these systems are often insufficient to meet the
needs of IT financial management processes.

To meet IT’s financial management needs, costs must usually be enhanced with more information.
This enhancement can be as simple as adding a relationship to the cost that does not currently
exist, or it can be as complex as relating a portion of the cost to more than one dimension (for
example, splitting the cost 70% to one organization and 30% to another organization). The process
of enhancing the cost is called cost allocation.
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Financial Planning and Analysis (FPA) uses a method of allocating costs to create new records that
reflect changes that the organization would like to make without altering the original cost records.
FPA uses Allocation Rules to select which cost records to change and to specify how the new cost
records will look.

Often, the organization needs to change the cost records through a series of steps to reach the
desired level of detail. This series of steps could involve hundreds of rules. To help organizations
manage their Allocation Rules, FPA groups rules into Allocation Stages. These stages help the
organization systematically transform the original costs into an enriched set of costs. The
organization can use the result of this process in its analysis of planned and actual costs.

The allocation process is a way of using a set of assumptions to transform the way costs are
distributed among business entities. Organizations can apply different sets of assumptions to the
same set of costs, creating different results. An organization may want to compare the
assumptions or they may have different sets of assumptions to support different analysis purposes.
To support these needs, FPA enables users to create Allocation Scenarios. Each scenario encodes
a set of assumptions and produces a set of results that can be analyzed independently of other
allocation results.

A well-developed Allocation Scenario includes assumptions for both planned costs and actual
costs. By relating both types of costs to the same lists of relationships, an organization can analyze
performance to budget and better understand cost drivers. FPA includes several ways to analyze
the allocation results. For financial analysts, FPA offers a streamlined interface called Cost
Explorer that helps the analyst answer ad hoc questions quickly. For business users and IT
management, FPA offers out-of-box analytics that show important financial data concerning
dimensions like organizations and business services. FPA also offers a dashboard that helps users
quickly identify IT financial areas that require attention.

How do | add an allocation scenario?
1. From the main menu bar, click Allocations > Scenarios.
Click New.

2
3. Type an allocation Scenario name.

4. Optional. Type a Description.

5. Optional. Select Display on dashboard. This sets this scenario as the default scenario that
the dashboards display. You can have only one default scenario, which is the basis for all
financial analytics.

6. Optional. Select Process new data to enable the allocation engine to recalculate the costs
whenever new data arrives.

7. Set bounds to limit the amount of data to consider for allocation.
a. Select a Start period from the drop-down list.

For budget allocation scenarios, follow these guidelines when you select the start period:

o If the budget granularity is yearly, define the allocation scenario starting from the month
that the fiscal year starts. For example, the fiscal year starts April 2011, and the budget
is defined for April 2011 to April 2012. When you set the start period for the budget
allocation scenario, select April 2011.
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o If the budget granularity is quarterly, select the first month of the quarter for which you
want the budget allocation to start.

o If the budget granularity is monthly, you can select any month in the budget.
b. Select an End period from the drop-down list.

Note: You can set No end period as the selection. The allocation engine processes the
latest period in the data.

8. Click Save to add new stages to the allocation scenario.

9. Click Save and Close to return to the complete list of allocation scenarios.

How do | copy an allocation scenario?
1. From the main menu bar, click Allocations > Scenarios.
Click the allocation scenario to be copied.
Click Copy.
Type a unique New scenario name.

Optional. Type a new scenario Description.

o o k~ w Db

Click Copy to return to the detail page of the copied record.

How do | delete an allocation scenario?
1. From the main menu bar, click Allocations > Scenarios.
Select the check box for the allocation scenario to be deleted.

Click Delete.

> w0 N

Click OK to confirm the deletion.

How do | filter a list of allocation scenarios?
1. From the main menu bar, click Allocations > Scenarios.

2. Do one of the following actions:
= Type afilter value in the text box at the top of the Scenario name column.

» Type a partial filter value.
3. Click Filter.
Examples

o If you type scenario, Financial Planning and Analysis finds all allocation scenarios that contain
the letters scenario, such as AllocationScenario001, ScenarioX, or Newscenario. A wildcard
character is assumed before and after the filter value.

o If you type scenario*, Financial Planning and Analysis finds all allocation scenarios that begin
with the letters scenario, such as ScenarioX.
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o If youtype *scenario, Financial Planning and Analysis finds all allocation scenarios that end with

the letters scenario, such as Myscenario.

How do | update an allocation scenario?

1.

2
3.
4.
5

From the main menu bar, click Allocations > Scenarios.

Click the allocation scenario to be updated.

Edit any field. You can also add, delete, and reorder stages in this scenario.
Click Save to update this scenario.

Click Save and Close to return to the complete list of allocation scenarios.

How do | view an allocation scenario?

1.

From the main menu bar, click Allocations > Scenarios.
From this list, you can add, delete, or filter an allocation scenario.

To view the details for any allocation scenario, or copy an allocation scenario, click the
allocation scenario.

How do | add an allocation stage to a scenario?

1.
2.
3.

From the main menu bar, click Allocations > Scenarios.
Click the allocation scenario.

To add a planned cost or an actual cost stage:
a. Onthe Planned Cost Stages or Actual Cost Stages tab, click New.

b. Type an allocation Stage name.

c. Optional. Type a Description.

d. Choose the Target dimension from the drop-down list.

e. Optional. Select Pass remaining costs to the next stage to calculate all costs.

Note: Costs carry forward from stage to stage. If all costs are not allocated, the
unallocated costs are not included in the calculation.

f. Click Save to add allocation rules to the stage.

g. Click Save and Close to return to the allocation scenario detail page to view the list of cost
stages.

How do | delete an allocation stage from a scenario?

1.
2.
3.

From the main menu bar, click Allocations > Scenarios.
Click the allocation scenario that has the stage to be deleted.

On the Planned Cost Stages or Actual Cost Stages tab, select the check box for the
allocation stage to be deleted.
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4. Click Delete. This action deletes the cost stage, refreshes the stage list for this scenario, and
causes the allocation engine to recalculate.

5. Click OK to confirm the deletion.

2: Define allocation stages

An allocation stage distributes costs across your business model. It enriches the data in the Cost
table by adding relationships, or dimensions, with special criteria called allocation rules.

When adding multiple stages to an allocation scenario, Financial Planning and Analysis calculates
the information incrementally. The second stage uses the result of the first stage to add
relationships.

The goal is to implement rules that relate all costs to the chosen relationship. Complete coverage
provides the richest analysis. If the rule set does not include all of the costs, the system provides a
method to allocate the remaining costs.

Allocation stage

An allocation stage enables you to enrich cost information by distributing costs across your
business model. To allocate costs to a stage, you add allocation rules where you specify what
criteria to include. Each stage uses the results of the previous stage.

How do | add an allocation stage?

1. From the main menu bar, click Allocations > Scenarios.

2. Click the allocation scenario.

3. Toadd a planned cost or an actual cost stage:

a.
b.

C.

On the Planned Cost Stages or Actual Cost Stages tab, click New.

Type an allocation Stage name.

Optional. Type a Description.

Choose the Target dimension from the drop-down list.

Optional. Select Pass remaining costs to the next stage to calculate all costs.

Note: Allocated costs always carry forward from stage to stage. If all costs are not
allocated, the unallocated costs from this stage are not included in the available cost pool
for the next stage's allocation. Selecting “pass remaining costs to the next stage” ensures
that ALL costs are carried forward to the next stage, regardless of whether they were re-
allocated by an allocation rule in this stage.

Click Save to add allocation rules to the stage.

Click Save and Close to return to the allocation scenario detail page to view the list of cost
stages.

How do | delete an allocation stage?

1. From the main menu bar, click Allocations > Scenarios.

2. Click the allocation scenario that has the stage to be deleted.
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3. Onthe Planned Cost Stages or Actual Cost Stages tab, select the check box for the
allocation stage to be deleted.

4. Click Delete. This action deletes the cost stage, refreshes the stage list for this scenario, and
causes the allocation engine to recalculate.

5. Click OK to confirm the deletion.

How do | reorder allocation stages in a scenario?
1. From the main menu bar, click Allocations > Scenarios.
2. Click the allocation scenario that has the stages to be reordered.

3. Onthe Planned Cost Stages or Actual Cost Stages tab, select the check boxes for the
allocation stages to be reordered.

4. Click Move Up or Move Down to change the order. This action refreshes the list sequence.

The allocation engine recalculates the cost based on the new order.

How do | update an allocation stage?
1. From the main menu bar, click Allocations > Scenarios.
2. Click the allocation scenario that has the stage to be updated.

3. Onthe Planned Cost Stages or Actual Cost Stages tab, click the allocation stage to be
updated.
a. Edit any field.
Note: You cannot change the Target dimension when it has rules. To change the Target
dimension, you must first delete all rules from the Allocation Stage detail page.

b. Click Save to add, delete, update, or reorder rules to this stage.

c. Click Save and Close to return to the Allocation Scenario detail page to view the list of
stages.

How do | view a list of allocation stages?
1. From the main menu bar, click Allocations > Scenarios.

2. Click the allocation scenario that has the allocation stages to be viewed. On the Actual Cost
Stages tab and the Planned Cost Stages tab, you can view the list and add, delete, update, or
reorder allocation stages.

3. Toview the details for any allocation stage, or add a new rule to the stage, click the allocation
stage.

How do | add an allocation rule to an allocation stage?
1. From the main menu bar, click Allocations > Scenarios.
2. Click the allocation scenario of the associated stage with the rule to be added.

3. Onthe Planned Cost Stages tab or the Actual Cost Stages tab, click an existing allocation
stage.
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4. Above the Rule name column, click New.
5. Type an allocation Rule name.
6. Optional. Type a Description.

Note: You can add a rule as a placeholder in the stage without defining the allocation criteria
immediately. The scenario remains in Draft mode until all rules are defined.

7. Click Save to add Cost Source and Cost Target information.

8. Click Save and Close to return to the Allocation Stage detail page to view the list of rules.

How do | delete an allocation rule from an allocation stage?
1. From the main menu bar, click Allocations > Scenarios.
2. Click the allocation scenario of the associated stage with the rule to be deleted.

3. Onthe Planned Cost Stages or Actual Cost Stages tab, click the stage with the rule to be
deleted.

4. Select the check box for the allocation rule to be deleted.

5. Click Delete. This action deletes the rule from this stage. The allocation engine recalculates
the cost for the scenario.

3: Define allocation rules

Allocation rules enable you to create a link between planned and actual costs for the purpose of
comparison. The allocation rule interface helps you build valid rules quickly and easily.

After creating a rule, the allocation engine calculates the results. A status bar indicates how much
of the costs are allocated. The goal is to implement rules that relate all costs to the chosen
relationship.

Rules can transform the data. A bar chart displays the cost relationships before and after allocation.
Light green bars indicate that costs were assigned prior to allocation. Aqua bars indicate post-
allocation costs.

Allocation rule

An allocation rule provides a way to create new records that reflect cost changes without altering
the original cost records. A rule describes which costs to retrieve and how to assign the costs, thus
enriching the cost information.

For example, you can define Rule1 to find all costs that have a relationship with a project. Any
costs that meet the criteria are assigned to the project. You can then define Rule2 to split the costs
across a project. The results of these rules help you make better business decisions.

How do | add an allocation rule?
1. From the main menu bar, click Allocations > Scenarios.

2. Click the allocation scenario of the associated stage with the rule to be added.
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3. Onthe Planned Cost Stages tab or the Actual Cost Stages tab, click an existing allocation
stage.

4. Above the Rule name column, click New.
5. Type an allocation Rule name.
6. Optional. Type a Description.

Note: You can add a rule as a placeholder in the stage without defining the allocation criteria
immediately. The scenario remains in Draft mode until all rules are defined.

7. Click Save to add Cost Source and Cost Target information.

8. Click Save and Close to return to the Allocation Stage detail page to view the list of rules.

How do | add Cost Source and Cost Target criteria?

You must define and save the information from the Cost Source and Cost Target tabs to complete
creating the rule.

The Cost Source tab enables you to create a rule representing a Boolean expression similar to a
Where clause in a SQL statement. Using the drag-and-drop operation, you can determine what
basic cost records to consider for the allocation.

To add Cost Source criteria

1. From the main menu bar, click Allocations > Scenarios.

2. Click the allocation scenario of the associated allocation stage containing the rule to be
defined.

3. Onthe Planned Cost Stages or Actual Cost Stages tab, click an existing allocation stage.
4. Click an existing rule.

5. Onthe Cost Source tab, drag a cost object from the Cost model tree menu and drop it in the
Cost selection criteria area. The expression is in Edit mode.
= Click the down arrow in the first field to change the source data table or column name.

= Click the down arrow in the second field to change the operator.

= If applicable, click the down arrow in the third field to select another value. If the dimension

has too many values, click the Search icon. Q
o Type avalue in the text box.

o Click the Searchicon.
o Select the items to include in the filter.
o Click Select.

6. Do one of the following actions:
= Click Save at the end of the expression to save it.

= Click Cancel at the end of the expression to remove it. %]
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= Click Cancel at the top of the page to return to the list of rules for this stage without saving
any expressions.

Roll the cursor over any expression to view Edit and Remove icons.
» Click Edit at the end of the expression to make changes. ¢
" Click Remove at the end of the expression to delete it. o

= Click Cancel at the top of the page to return to the list of rules for this stage without saving
any expressions.

Continue the drag-and-drop operation until the rule is complete. You can drag an object to one
of four drop zones:
= Anempty work area.

= Within the grouping box that encloses expressions joined by conjunctions.
= Outside the grouping boxes.
= Onto an existing expression.

Click AND to change it to OR to group the expressions into a new group box. You can change
OR to AND by clickingiit.

The Cost Target tab enables you to distribute costs to your target equally, by a fixed percentage, or
using metric allocation. The allocation options are Equally and By percentage.

To add Cost Target criteria

1.
2.

Click the Cost Target tab.

From the Allocate costs drop-down list, select the allocation type.

= Equally: Distributes amounts evenly. For example, you have Dept1 and Dept2. The
allocation engine allocates 50% of each cost row to Dept1 and 50% of each cost row to
Dept2. If you specify only one target, 100% of the costs are allocated to that target.

= By percentage: Distributes by entering the proportion for each value. For example, you
select 70% for Dept 1 and 30% for Dept 2. The allocation engine allocates 70% of each cost
row to Dept 1 and 30% of each cost row to Dept 2.

= Metric based - selected targets: Distributes costs by the dimension names selected from
the list of objects in the target dimension. You must then select a Metric Name from the
drop-down list. For example, you select the Organization dimension with Corporate Finance
and Corporate IT as the selected target values and Headcount as the metric name. In this
case, the allocation engine distributes costs based on the headcount of these two targets.

= Metric based - all targets: Distributes costs to all targets listed in the target dimension.
The target value list no longer appears on the page. You must then select a Metric Name
from the drop-down list. For example, you select all targets of the Organization dimension
and Headcount as the metric name, The allocation engine distributes costs based on the
headcount to every target in the Organization dimension.

If you selected metric based allocation, choose the Metric Name from the drop-down list. The
metric table of the selected dimension provides the list of metric names.

Page 33 of 100 HP Financial Planning and Analysis (9.20)



Application User Guide
Chapter 4: Allocations

4. From the Target dimension column on the left, select the records that you want to add to the
Target value column on the right. You can select multiple records by holding the Ctrl key and
selecting the check boxes next to the records to add. The bottom of the column displays the
total number of records for the dimension. You can do the following actions:
= If there are 10 or fewer records, select the records to add to the target value and click the

right arrows.

= If there are more than 10 records, select the records to add on each page and click the right
arrows. To navigate to other pages, you can click the next arrow or type a page number at
the bottom of the column.

= Type avalue in the textbox and click Filter to narrow the record search.
= Toremove atarget value, click the check box beside the record, then click the left arrows.
5. Click Save to save Cost Source and Cost Target information.

6. Click Save and Close to return to the Allocation Stage detail page to view the list of rules.

How do | delete an allocation rule?
1. From the main menu bar, click Allocations > Scenarios.
2. Click the allocation scenario of the associated stage with the rule to be deleted.

3. Onthe Planned Cost Stages or Actual Cost Stages tab, click the stage with the rule to be
deleted.

4. Select the check box for the allocation rule to be deleted.

5. Click Delete. This action deletes the rule from this stage. The allocation engine recalculates
the cost for the scenario.

How do | reorder allocation rules in a stage?
1. From the main menu bar, click Allocations > Scenarios.
2. Click the allocation scenario of the associated stage with the allocation rules to be reordered.

3. Onthe Planned Cost Stages or Actual Cost Stages tab, click the allocation stage with the
allocation rules to be reordered.

4. Select the rules to reorder.
5. Click Move Up or Move Down to change the order. This action refreshes the list sequence.

The allocation engine recalculates the cost based on the new order.

How do | update an allocation rule?
1. From the main menu bar, click Allocations > Scenarios.
2. Click the allocation scenario of the associated stage with the rule to be updated.

3. Onthe Planned Cost Stages or Actual Cost Stages tab, click the stage with the rule to be
updated.

4. Click the allocation rule to be updated.
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5. Edit any field on the detail page, Cost Source tab, or Cost Target tab.
6. Click Save to save the changes.
7. Click Save and Close to return to the Allocation Stage detail page to view the list of rules.

The allocation engine recalculates the cost data when the cost source or cost target criteria are
modified.

How do | view an allocation rule?
1. From the main menu bar, click Allocations > Scenarios.
2. Click the allocation scenario of the associated allocation stage that has the rule to be viewed.

3. Click the allocation stage that has the rule to be viewed.
From this list, you can add, delete, or reorder an allocation rule.

4. To view the details for any allocation rule, click the allocation rule.

4: View Cost Explorer

The Cost Explorer tool enables you to interactively view and filter allocation results in the form of
charts that show variance between planned and actual costs. With Cost Explorer, you can easily

configure the chart views, providing the IT organization new insight and better alignment with the
business it supports.

Cost Explorer is accessible from an allocation scenario.

Cost Explorer

An analysis of costs is crucial to budgeting and planning. The Cost Explorer tool provides a multi-
dimensional cost analysis where you can easily change the analytic.

With Cost Explorer, you can do these tasks:

¢ Define the dimensions and measures you want to view.
o Save multiple configurations of the same scenario.

¢ Sort the chart order.

o Filteron all dimensions.

o Email the configuration link to others.

Cost Explorer provides the ability to examine the results of allocated costs and view variance
between planned and actual costs.

Configuration

A Cost Explorer configuration contains settings that you can define to display chart views of your
scenario. You can define multiple configurations for your scenario to provide different views. The
default configuration includes these settings:

e Fiscal month on the x-axis

e Plan and actual cost allocations
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o Reference currency from the source data

You can easily change the chart views to provide additional analytics.

Measures

Cost Explorer enables you to compare cost measures that provide information about the variance
between planned and actual costs. Cost Explorer validates which measures you can compare.

The analysis can include these measures:

¢ Current sum of plan and actual, which is the latest displayed period in the chart.

o Cumulative sum of plan and actual, which contains the amount of all the displayed periods.

o Variance value, which compares the planned and actual costs.

e Percent variance of actual and cumulative values.

How do | add a configuration?

1. From the main menu bar, click Allocations > Scenarios.

2. Under Actions, click Cost Explorer for the scenario with the configuration to be added.

3. Configure the settings.

a. Onthe Settings tab, choose a dimension from the Group by these dimensions (y-axis)
drop-down list. You can choose up to three unique dimensions.

b. Choose one dimension from the And (x-axis) drop-down list. The default is Fiscal Month

c. Choose up to three measures from the Use these measures drop-down list. The default
measures are Plan and Actual.

d. Toassign a different color to the measure, click the color icon next to the measure and
select a color.

e. Choose aview to Sort charts by from the drop-down list. This displays the charts in your
order of preference.

f. Choose the currency type from Filter costs by currency . The default is Show all costs
(reference currency). You can choose a different currency from the Show cost subset
drop-down list.

g. Choose a value from the Use this scale drop-down list. The currency scale can be
thousands or millions.

h. Choose a value from the Chart height drop-down list to change the size of the chart.

4. Onthe Filters tab, choose a dimension from the drop-down list and do one of the following
steps:

a. Select the values from the drop-down list to display on the chart.

b.

If the dimension has too many values to list, click the Search icon. Q
i. Typeavalue in the text box.

ii. Click Search.
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iii. Select the items to include in the filter list.
iv. Click Select to add the items to the filter list.
5. Click Update Chart to view the configuration change results.
Note: You can click Update Chart at any time to view configuration changes.

6. Click Save as to save these settings as a new configuration.
a. Typethe name.

b. Click OK.
c. Click OK to confirm the new configuration.

7. Optional. Click Email Link to send the configuration URL to another user. The recipient must
have a valid user name and password to access the configuration.

How do | delete a configuration?
1. From the main menu bar, click Allocations > Scenarios.
2. Under Actions, click Cost Explorer for the scenario with the configuration to be deleted.
3. Select the configuration to be deleted in the Default Configuration drop-down list.
4. Click Delete.
5. Click OK to confirm the deletion.

How do | email a configuration link?

1. From the main menu bar, click Allocations > Scenarios.

2. Under Actions, click Cost Explorer for the scenario with the configuration link to be sent.
3. Select a configuration in the Default Configuration drop-down list.
4

Click Email Link to send the configuration URL to another user. The recipient must have a
valid user name and password to access the configuration.

How do | update a configuration?

1. From the main menu bar, click Allocations > Scenarios.
Under Actions, click Cost Explorer for the scenario to be updated.
Choose a configuration in the Default Configuration drop-down list.
Edit any field.

Click Update Chart to view the configuration change results.
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Do one of the following actions:
a. Click Save to save the current settings for this configuration.

b. Click Save as to add these settings as a new configuration.
i. Typethe name.

ii. Click OK.
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7.
8.

Click OK to confirm.

Optional. Click Email Link to send the configuration URL to another user. The recipient must
have a valid user name and password to access the configuration.

How do | view Cost Explorer?

1.
2.

From the main menu bar, click Allocations > Scenarios.
Under Actions, click Cost Explorer for the scenario to be viewed.

From this view you can add, delete, save, or update a configuration. You can send the
configuration URL to another user.

If you edit any field on the Settings or Filters tab, click Update Chart to view the configuration
change results.

How do | view another configuration of the scenario?

1.
2.
3.

From the main menu bar, click Allocations > Scenarios.
Under Actions, click Cost Explorer for the scenario with the configuration to be viewed.

Select a configuration in the Default Configuration drop-down list. From this view you can
add, delete, save, or update a configuration. You can send the configuration URL to another
user.

If you edit any field on the Settings or Filters tab, click Update Chart to view the configuration
change results.

How do | update a view of cost measures?

1.

2
3.
4

o

From the main menu bar, click Allocations > Scenarios.
Under Actions, click Cost Explorer for the scenario to be updated.
Choose a configuration in the Default Configuration drop-down list.

Choose up to three measures from the Use these measures drop-down list. The default
measures are Plan and Actual.

Click Update Chart to view the results.

Do one of the following actions:
a. Click Save to save the current settings for this configuration.

b. Click Save as to save these settings as a new configuration.
i. Typethe name.

ii. Click OK.
Click OK to confirm.

Optional. Click Email Link to send the configuration URL to another user. The recipient must
have a valid user name and password to access the configuration.
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How do | sort charts?

1.
2.
3.

From the main menu bar, click Allocations > Scenarios.
Under Actions, click Cost Explorer for the scenario with the charts to be sorted.

Choose aview to Sort charts by from the drop-down list. This displays the charts in your order
of preference. You can sort charts by these parameters:
= Default. Alphabetical by the y-axis

= Cumulative actual, plan, or variance values

= Maximum actual, plan, variance, or % variance values
Note: If all charts have the same sorting score, the charts are sorted alphabetically.

Click Update Chart to view the sort results.

Do one of the following actions:
a. Click Save to save the current settings for this configuration.

b. Click Save as to save these settings as a new configuration.
i. Typethe name.

ii. Click OK.
Click OK to confirm.

Optional. Click Email Link to send the configuration URL to another user. The recipient must
have a valid user name and password to access the configuration.

How do | add a filter in Cost Explorer?

1.

2
3.
4.
5

From the main menu bar, click Allocations > Scenarios.

Under Actions, click Cost Explorer for the scenario with a filter to be added.
Choose a configuration in the Default Configuration drop-down list.

On the Filters tab, choose a dimension from the drop-down list.

Do one of the following actions:
a. Select the values from the drop-down list to display on the chart.

b. If the dimension has too many values to list, click the Search icon. Q
i. Type a partial value in the text box.

ii. Click Search.
iii. Click Select to add the items to the filter list.
Click Update Chart to view the results.

Do one of the following actions:
a. Click Save to save the current settings for this configuration.

b. Click Save as to save these settings as a new configuration.
i. Typethe name.

ii. Click OK.
Click OK to confirm.
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9. Optional. Click Email Link to send the configuration URL to another user. The recipient must
have a valid user name and password to access the configuration.

5: Publish results

By publishing results to the data warehouse after you create an allocation scenario, the rules
become available to the data warehouse for continuous processing. The Extract, Transform, and
Load (ETL) process loads data from the original cost table and creates new records in a separate
environment.

A status box indicates the state of your request and what actions are available. For example, when
the state is Publication Requested, you can cancel the request.

Status Available Action

Publish Requested Cancel
Publish started {date/time} Unpublish
Published {date/time} Unpublish
Unpublish Requested Cancel
Unpublished started {date/time} | Publish

When you first create the scenario, it is in unpublished mode. You can continue to update the
scenario in this mode.

How do | publish results?
1. From the main menu bar, click Allocations > Scenarios.
2. Click the allocation scenario to be published.

3. Inthe Publishing status box, click Publish. The publication start date and time appear in the
Publishing status box when the Extract, Load, and Transform (ETL) process begins.

Note: You cannot update the scenario during this process.

How do | unpublish results?
1. From the main menu bar, click Allocations > Scenarios.
2. Click the allocation scenario to be unpublished.

3. Inthe Publishing status box, click Unpublish. The unpublication start date and time appear
in the Publishing status box when the Extract, Load, and Transform (ETL) process begins.
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Budgeting

The budgeting tool is a component of Financial Planning and Analysis (FPA) that enables IT finance
managers to plan a budget for three different planning time frames: one, two, or three years. The
budget tool provides finance managers with these options:

o Define the budget configuration.

« Send notification to all or selected IT cost center managers.

o Enter budget data at the cost center level.

o Check the status of the review process for one or all IT cost centers.

« Review graphical views of consolidated budgets.

o Publish budgets that populate the data warehouse with cost center plans.

To use budgets

1. From the main menu bar, click Budgeting > Budgets.

2. Select an option.

Budgeting workflow

The tasks that you complete in the budgeting workflow depend on the Financial Planning and
Analysis (FPA) user group that you are assigned to. The table below describes the FPA budgeting
user roles and responsibilities:

Budgeting user roles and responsibilities

User role

Assigned role in FPA

Responsibility

Budget Coordinator

FPA_BUDGET_COORDINATOR

Defines the budget
configuration. Notifies
the cost center
managers to populate
the budget line items,
follows up with cost
center managers for
timely update of
budgets, and reviews
the input from all
included cost centers.
Publishes the budget to
use in allocation
scenarios.

Cost Center Manager

FPA_COST_CENTER_MANAGER

The source for the
budgeting data. Receive
notifications from the
Budget Coordinator that
budget data is needed
for your cost centers.
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User role

Assigned role in FPA

Responsibility

Enter budget data using
the FPA application or
export the budget
template to Microsoft
Excel and work offline.

Financial Analyst

FPA_ADMIN

Use published budgets
in allocation scenarios.
For information about
the other FPA features
that a Financial Analyst
has access to, see
"Security roles" (on page

22)

CIO, CFO

FPA_ANALYTIC

View the consolidated
budget.

The graphic below illustrates the budgeting workflow. The colors indicate which user is responsible

for completing the task.
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Budgeting workflow

View the
consolidated
budget

Define the Finalize the budget Enter budget
Create a budget budget definition and notify data for your
configuration cost center managers cost centers

Acceptor ™
Review cost reject cost center )
center budgets budgets

Mark cost
center budgets
accepted

Mark the cost
center budgets
completed

Accept the Publish the View the
consolidated consolidated consclidated
budget budget budget

. Budget Coordinator

B Cost Center Manager . .
View the View the

B Financial Analyst consolidated consolidated Create allocation
.- i scenarios
Bl co budget budget

How do | create and define a budget?
You can create and define budgets if you have FPA Budget Coordinator privileges.
1. From the main menu bar, click Budgeting > Budgets.
2. Click New.

3. Complete these required fields:
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Type a budget Name.

From the Time Frame (years) drop-down list, select the number of years in the budget
plan.

From the Start Period drop-down list, select the fiscal year that the budget starts.

From the Frequency drop-down list, select the granularity for budget data entry. If you
select Monthly, Cost Center Managers can enter budget amounts for each month. If you
select Quarterly, Cost Center Managers can enter budget amounts for each quarter, but
they cannot edit amounts by month. And if you select Yearly, Cost Center Managers can
enter budget amounts for each year, but they cannot edit amounts by quarter or month.

From the Unit of Measure drop-down list, select the unit of measure for the amounts in the
budget.

4. Click Save.

5. Add Cost Centers to the budget:

a.
b.

C.

d.

e.

Click the Cost Centers tab if necessary.
Select a cost center in the Source pane. Press ctrl and click to select multiple cost centers.

Click Include >. FPA moves the selected cost center or cost centers to the Target pane
and includes these cost centers in the budget.

Repeat steps a—c for each cost center that you want to add to the budget.

Click Save.

6. Create the cost category groups that you want to include in the budget:

a.
b.
C.

d.

Click the Cost Categories tab.
Click Create Group*. FPA adds a New Group folder in the Target pane on the right.
Type a name for the cost category group. For example, Hardware.

Repeat steps a — ¢ to create additional cost category groups.

7. Add cost categories to the cost category groups:

a.

b.

C.

d.

Click the group for which you want to add cost categories.

Select a cost category in the Source pane. Press crtl and click to select multiple cost
categories.

Click Include >. FPA moves the cost category or cost categories to the selected group.

Repeat steps a— ¢ for each cost category group.

8. Click Save.

9. Click Close if you want to save a draft budget that you can edit. Or click Finalize if you know
that you will not change the budget.

How do | copy a consolidated budget?

If you have FPA Budget Coordinator privileges, you can copy a consolidated budget to use as a
template for new budget.
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1. From the main menu bar, click Budgeting > Budgets.
Select the budget that you want to copy.
Click Copy as.

> w0 N

Type a name for the new budget and make and appropriate changes to the fields.

How do | update a budget definition?

You can edit budget definitions for budgets that are in Draft status if you have FPA Budget
Coordinator privileges.

1. From the main menu bar, click Budgeting > Budgets.

2. Inthe Action column click the Edit icon next to the budget that you want to edit. &
3. Edit any field.
4. Click Save.

How do | finalize a budget definition?
You can finalize budget definitions if you have FPA Budget Coordinator privileges.
1. From the main menu bar, click Budgeting > Budgets.

2. Inthe Action column click the Edit icon next to the cost center budget that you want to finalize.
&

The New/Edit Budget screen opens.
3. Click Finalize.
4. Click OK to confirm that you want to finalize the budget.

FPA closes the New/Edit Budget screen. The budget status remains Defined.

How do | notify cost center managers to ask for their budget
data?

If you have FPA Budget Coordinator privileges, you can notify cost center managers to complete
their budgets.

1. From the main menu bar, click Budgeting > Budgets.

2. Inthe Action column on the top pane, click the Notify icon next to the budget that you want to
*
accept.

The Notification Management screen opens.
3. Select the cost centers that you want to notify.

4. You can edit the Manager Name and Manager Email if necessary. However, note that
changing the Manager Name or email address transfers ownership of the cost center budget to
the manager that you list.
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5. Click Next >. FPA displays a draft email to the cost center manager(s) for the cost center(s)
that you selected. You can edit the email.

6. Click Send.

How do | enter budget data?

If you have FPA Cost Center Manager privileges, you can use the FPA application or Microsoft
Excel to enter budget data into the budgets for your cost centers.

1. From the main menu bar, click Budgeting > Budgets.

2. Click the Cost Centers tab to view the cost centers for which you can enter budget data.

3. Inthe Action column click the Edit icon next to the cost center budget that you want to edit. &

The Administrative screen opens and enables you to enter budget data. Each cost center group
that you are responsible for becomes a tab in the data entry table. You can view a summary for
all cost center groups by clicking the Summary tab.

4. Decide how you want to enter budget data and then enter the data:
= Toenter budget data using the FPA user interface:
i. Click the tab for the cost category group that you want to enter data for. Depending on
the frequency that the Budget Coordinator chose for this budget, you can enter data for
each month, quarter, or year.

ii. Click acellin the row for a cost category. If the frequency for the budget is Monthly,
you can edit the cells for each month. If the frequency for the budget is Quarterly, you
can edit the cells for each quarter. If the frequency for the budget is Yearly, you can
edit the cells for each year.

iii. Type the appropriate amounts for each time period for each cost category. You can
expand or collapse columns by clicking + or —in the column headings. You can view
the chart above the data entry table to see a visual representation of the amounts that
you enter. You can also view this chart to see how the budget costs that you enter
compare to the actual cost of the budgets from the previous time period.

iv. Click Save.

v. Click Close if you want to save a draft cost center budget that you can edit. Or click
Mark Complete if you know that you will not change the budget.

vi. Repeat steps i —v for each cost category group.

= To enter budget data using Microsoft Excel:
i. Click Export.

ii. Click Save in the Export Budget Data dialog box, and then select a location to save the
xlIs file. You can rename this file.

iii. Open the spreadsheet that you saved in the previous step. Each cost category group
becomes atab in the file.
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iv. Click the tab for the cost category group that you want to enter data for. Depending on
the frequency that the Budget Coordinator chose for this budget, you can enter data for
each month, quarter, or year.

v. Type the appropriate amounts for each time period for each cost category. Follow
these guidelines when you edit budget spreadsheets:
o Do not add or delete rows or columns.

o Do not edit the summary information at the top of the file.

o Do not edit column headings.

o Edit only the amounts for each time period in the row for each cost category.
vi. Save and close the spreadsheet.

vii. Returnto FPA and open the cost center that corresponds to the spreadsheet that you
saved.

viii. Click Import.

ix. Select the spreadsheet for the cost center and click Open. FPA imports the data from
the spreadsheet.

x. Click Save.

xi. Click Close if you want to save a draft cost center budget that you can edit. Or click
Mark Complete if you know that you will not change the budget.

xii. Repeat steps i — xi for each cost center.

How do | mark a cost center budget complete?
You can mark cost center budgets complete if you have FPA Cost Center Manager privileges.
1. From the main menu bar, click Budgeting > Budgets.
2. Click the Cost Centers tab.

3. Inthe Action column click the Edit icon next to the cost center budget that you want to mark
complete. £

4. Click Mark Complete.
5. Click OK to confirm that you want to mark the cost center budget complete.

6. Click Close to close the cost center budget.

How do | review and accept or reject completed cost center
budgets?

You can review and accept or reject completed cost center budgets if you have FPA Budget
Coordinator privileges.

1. From the main menu bar, click Budgeting > Budgets.

2. Click the Cost Centers tab.
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In the Action column click the Review icon next to the cost center budget that you want to

review. @‘

Click each cost category group tab to review the budget amounts.

Click Acceptif you want to accept the cost center budget. Or click Reject if you want the cost
center manager to make changes. If you reject a cost center budget, FPA sends an email to
the cost center manager for that budget to notify him or her that you rejected their budget and
that they need to make changes. Once the cost center manager edits the budget and marks it
complete, you have another opportunity to accept or reject it.

Click OK to confirm that you want to accept or reject the cost center budget. You can use the <
Prev or Next > buttons to open the previous or next cost center budget.

Click Close.

Repeat steps 1 —6 for each cost center budget that you want to review.

How do | accept the consolidated budget?

Once you have accepted all of the cost center budgets included in an overall budget, you can
accept the consolidated budget. You can accept the consolidated budget if you have FPA Budget
Coordinator privileges.

1.
2.

From the main menu bar, click Budgeting > Budgets.

In the Action column click the Consolidated Budget icon next to the budget that you want to
accept. L:J

The Consolidated Budget View screen opens.

Click Accept.

Click OK to confirm that you want to accept the consolidated budget. The cost center budget
status changes to Accepted.

How do | publish the consolidated budget?

Once you have accepted the consolidated budget, you can publish it so that Financial Analysts can
use the budget in allocation scenarios. You can publish the consolidated budget if you have FPA
Budget Coordinator privileges.

1.
2.

From the main menu bar, click Budgeting > Budgets.

In the Action column click the Consolidated Budget icon next to the budget that you want to
publish. [

The Consolidated Budget View screen opens.

Click Publish.

Click OK to confirm that you want to publish the consolidated budget. The budget status
changes to Published.
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How do | view the consolidated budget?

If you have FPA Budget Coordinator privileges, you can view the consolidated budget at any time in
the budgeting workflow. If you have FPA Financial Analyst or FPA CIO privileges, you can view the
consolidated budget after the Budget Coordinator accepts or publishes the budget.

1. From the main menu bar, click Budgeting > Budgets.

2. Inthe Action column click the Consolidated Budget icon next to the budget that you want to
view. -:J

The Consolidated Budget View screen opens. The pie chart on the top left of the screen shows
the budget distribution by the top ten cost category groups with the biggest budgets. You can
move your mouse pointer over a slice in the pie chart to see the percent of the budget that the
cost category group is assigned. If you click a cost category group in the pie chart, FPA
displays in the pie chart on the top right of the screen the breakdown of the cost categories in
that group. The table at the bottom of the screen shows the amounts designated for each cost
category for all cost centers in the budget.
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Dashboards

The dashboards let you view actual versus planned performance for customers, IT organizations,
business services, and programs. To help focus management attention, you can also use
dashboards to view the customers, IT organizations, business services, programs, and cost
categories that have the highest positive variance.

Use the FPA Dashboard and to help answer business questions such as these:

What is the actual versus planned cost for the top 10 customers, IT organizations, business
services, programs, and projects with the biggest budgets?

What customers, IT organizations, business services, programs, and projects have the highest
positive cost variance?

How accurate is our planning?
In what areas were expenses greater than anticipated?
What are the capitalized expenses compared to the operational expenses (CapEx or OpEx)?

What are the discretionary expenses compared to the non-discretionary expenses?

Data extracted from Project and Portfolio Management and Asset Manager populates these
dashboards:

Business Service

Customer

Financial Summary

IT Org
Program

To use dashboards

From the main menu bar, click Dashboards and select the dashboard.

Dashboards follow these standard rules:

When sorting by name, the order is case sensitive. All upper case terms appear first. For
example, APAC precedes Administration.

Pie charts display the top five items and add all remaining items to Others.

The displayed values in pie charts are rounded to thousandths. Percentage calculations are
based on the raw values.

Business Service dashboard

The Business Service dashboard provides an organization’s CIO, IT Financial Manager, IT
Financial Analyst and IT Manager a view of how business services are doing from the perspective
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of staying within their defined financial Plan of Record (PoR).

The dashboard has three tiers containing financial components. The first tier displays a high level
view of the data. The second tier consists of monthly, quarterly, and yearly graphs of the data. The
third tier shows tables that provide a more detailed view of the data.

Tier 1

The information on this tier displays a high-level view of the data. The selection list in the first
component displays up to the top 100 IT business services. These services can be sorted
alphabetically by name, or sorted from highest to lowest by budget amount or by variance amount.
The metrics in the charts of this tier are based on the business service that is selected from the first
component.

The YTD Plan Vs. Actual chart enables you to view your total IT planned costs versus actual costs
for the year-to-date. The chart can help answer these business questions:

¢ Is the business service staying within the PoR?
o How much spending does the business service have left in the PoR?

The YTD Actual Cost by Supplier pie chart enables you to view the top five suppliers by the highest
actual cost. The chart can help answer these business questions:

« What suppliers are consuming the majority of the actual cost?
o What percent of the actual cost is for all other suppliers?

The YTD Discretionary pie chart enables you to view your total discretionary cost versus non-
discretionary cost for the year-to-date. The chart can help answer this business question:

o What percentage of the actual cost is discretionary versus non-discretionary?

The YTD Actual Cost by Cost Category pie chart enables you to view the actual cost. The chart
can help answer these business questions:

o What is the allocation of the actual cost by category?

« Which categories account for the majority of the business service's actual cost?
o What percent of the actual cost is for all other cost categories?

Example

This example shows the top 100 IT business services sorted by the highest planned cost. The first
chart identifies the planned and actual costs. The second chart displays the top five suppliers with
the highest actual cost. The third chart lists the total discretionary cost versus non-discretionary
cost for a defined period. The last chart identifies the cost by category.

e

Frzo11 Kl Plan Vs. Actual ¥TD Actual Cost by Supplier ¥TD Discretionary
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The list below provides a description of the numbered items.

1. The drop-down option sorts up to the top 100 IT business services with the highest planned
costs.

a. The drop-down enables you to select the fiscal year for which you want to see data.

b. The colors preceding the business service identify the state of the plan:
Green indicates that the actual cost is within 100% of plan.
Yellow indicates that the actual cost is between 100 - 110% of plan.
Red indicates that the actual cost is over 110% of plan.

c. Business services are sorted by the highest planned costs. The drop-down option
determines the order of the list. The default is Business Service by Plan.
Business Service by Plan lists the business services by the highest planned costs.
Business Service by Variance lists the business services by those that are most over-
budget.
Business Service by Name lists the business services alphabetically.

2. ThePlan Vs. Actual chart numerically displays the planned costs, actual costs,and the
difference between them. The progress bar shows a negative difference between the planned
and actual costs in yellow. A vertical scale lists the percentage of planned versus actual.
Actual costs within 100% of the plan are green.

Actual costs between 100 - 110% are yellow.
Actual costs over 110% are red.

a. The vertical progress bar shows the actual cost.

b. The costs for plan, actual, and available (difference between the two) are listed in
thousands.

c. The percent indicates the actual cost divided by the plan cost multiplied by 100.

3. The YTD Actual Cost by Supplier pie chart lists the top five suppliers with the largest actual
cost year-to-date.

a. Thelegend identifies the supplier.

b. By placing the mouse pointer over the pie chart, you can view the allocation of the actual
cost by supplier and identify the majority of the actual costs. The "Other" label in the pie
chart displays the percentage of actual costs for all other suppliers.

4. The YTD Discretionary pie chart lists your total discretionary and non-discretionary costs for
the year-to-date.

a. The legend identifies which section of the pie chart shows discretionary spending and
which section shows non-discretionary spending.

b. By placing the mouse pointer over the pie chart, you can view the percentage of
discretionary costs and non-discretionary costs for the year-to-date.

5. The YTD Actual Cost by Cost Category pie chart displays the actual costs by cost category
in thousands.
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a. The legend identifies the cost category.

b. By placing the mouse pointer over the pie chart, you can view the allocation of the actual
cost by category and identify the majority of the actual costs. The "Other" label in the pie
chart displays the percentage of actual costs for all other cost categories.

Tier 2

The data in this tier enables you to view the monthly, quarterly, and yearly planned costs of the
business service you selected in Tier 1.

The Monthly Plan Vs. Actual chart initially displays the cost in months, starting with the first month
of the fiscal year. You have the option to display the information quarterly. The chart can help
answer these business questions:

« How well is the business service staying within the plan on a monthly and quarterly basis?
o When did actual spending exceed the plan?

The Historical Cumulative Actual/Year's Total Plan chart provides historical monthly and quarterly
data for the current year and two previous years. The chart can help answer this business question:

« How well is the business service staying within the budget based on historical spending of the
budget?

Example

This example has two charts that interact with Tier 1. The first chart shows the monthly and
quarterly plan. The second chart provides historical spending based on the current year and
previous two years.

/ 1 / ‘
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The list below provides a description of the numbered items.

1. The Plan Vs. Actual chart displays monthly or quarterly planned and actual costs for a fiscal
year. The vertical bar indicates what was planned and the blue diamond indicates what was
spent. You can select the vertical bar to display the Programs, Organization, Supplier, and
Cost Category details for that month or quarter in Tier 3. The selected bar is named in the
chart's subtitle. In the previous example, the selected baris FY2009/12. It is darker than the
other vertical bars. You can select the View by Month option to switch the display between
months and quarters.

Note: If a planned cost amount for a period is significantly less than the planned or actual cost
amounts for other periods, the chart may not display a gray bar for the period or periods with the
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lower planned cost amounts.

a. The highest amount on the vertical axis represents the maximum amount planned or spent
for a month or quarter within the current year.

b. The legend identifies the costs:
Planned amount: Square
Actual amount spent: Diamond

2. Historical Cumulative Actual/Year’s Total Plan provides a charting of percentage of actual
spend over time. Current year, plus the previous two years are charted, when data is available.
The percentage is the cumulative amount spent divided by the entire year's amount planned
times 100. For example, if the actual spent for January was 10 and 100 was planned, the
percentage will be 10%. If the actual spent in February was 15, the percentage displayed will
be 25% (the sum of January and February divided by the year's planned amount). If 120 was
spent over the year and 100 was planned, the percentage displayed will be 120%. Note that no
icon will appear on the chart if data does not exist for that period.

a. The highest amount on the vertical axis represents the maximum percentage of the budget
used for a month or quarter period within the current year and previous two years.

b. The legend identifies the year of the month or quarter:
Current year: X
Previous year: Circle
Two years ago: Triangle

Tier 3

The four tabs on this tier enable you to view actual and plan costs for the selected IT business
service for Programs, Organization, Supplier, and Cost Category. The information can help answer
these business questions:

o Where is the IT business service spending?
o Where does actual cost exceed the plan?

o What is the state of this IT business service's programs, organization, supplier, and cost
category?

Example

This example shows the details for the month or quarter selected in the Plan Vs. Actual chart from
Tier 2. The chart displays actual and plan costs for the cost category in January 2009. The table
lists the actual and plan costs.
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1 2

For STWOD01 223 in Jan /

Program

a b a b
The list below provides a description of the numbered items.

1. The bar chart displays actual and plan costs for the selected service in four areas: Programs,
Organization, Supplier, and Cost Category. Each area is a separate tab.

a. The horizontal bars display the actual and plan costs for the selected Programs,
Organization, Supplier, or Cost Category.

b. The legend identifies the costs:
Actual costs: Blue
Plan costs: Gold

2. Using data from the selected Programs, Organization, Supplier, or Cost Category tab, the table
shows the details of plan versus actual for the selected business service area.

a. Thetable lists the programs, organization, supplier, or cost category. Anicon to the left of
each name indicates how well the business service area is staying within the PoR.
Actual costs within 100% of the plan are green.

Actual costs between 100 - 110% are yellow.

Actual costs over 110% are red.

Note: Xcelsius does not display an alert icon when the planned cost for a program,
business service, supplier, or cost category is zero.

b. The table shows the actual and plan costs of programs, organization, supplier, or cost
category. By clicking any column header, you can sort by ascending or descending order.

Tier Interaction
The interactive dashboard dynamically updates the charts when you choose a business service,

change the option to view monthly or quarterly costs, drill down to get more details, or select a
Programs, Organization, Supplier, or Cost Category tab.
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The list below provides a description of the numbered items.
1. The drop-down option enables you to sort IT business services.
2. The drop-down enables you to select the fiscal year for which you want to see data.

3. By selecting an IT business service from this list, all charts in Tier 1, Tier 2, and Tier 3 will
change.

4. By selecting the View by Month or View by Quarter option, all charts in Tier 2 and Tier 3 will
change.

5. By selecting this bar chart, Tier 3 charts will change.

6. By selecting the Programs, Organization, Supplier, or Cost Category tab, the chart and table in
Tier 3 will change.

Customer dashboard

The Customer dashboard provides an organization’s CIO, IT Financial Manager, IT Financial
Analyst and IT Manager a view of how customers are doing from the perspective of staying within
their defined financial Plan of Record (PoR).

The dashboard has three tiers containing financial components. The first tier displays a high level
view of the data. The second tier consists of monthly, quarterly, and yearly graphs of the data. The
third tier shows tables that provide a more detailed view of the data.

Tier 1
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The selection list in the first component displays the top 100 customers. These customers can be
sorted alphabetically by name, or sorted from highest to lowest by plan amount or by variance
amount. The metrics in the charts of this tier are based on the customer that is selected from the
first component.

The YTD Plan Vs. Actual chart enables you to view a customer's total IT planned costs versus
actual costs for the year-to-date. The chart can help answer these business questions:

¢ Is the customer staying within the PoR?
o How much does the customer have left in the POR?

The YTD Actual Cost by Supplier pie chart enables you to view the top five suppliers by the highest
actual cost. The chart can help answer these business questions:

o Which top five suppliers are consuming the largest actual cost?
o What percent of the actual cost is for all other suppliers?

The YTD Discretionary pie chart enables you to view your total discretionary cost versus non-
discretionary cost for the year-to-date. The chart can help answer this business question:

o What percentage of the actual cost is discretionary versus non-discretionary?

The YTD Actual Cost by Cost Category pie chart enables you to view the actual cost. The chart
can help answer these business questions:

o What is the allocation of the actual cost by category?

« Which top five categories account for the largest actual cost?
o What percent of the actual cost is for all other cost categories?
Example

This example shows the top 100 customers that have the highest planned cost. The first chart
identifies the planned and actual costs. The second chart displays the top five suppliers with the
highest actual cost. The third chart lists the total discretionary cost versus non-discretionary cost
for a defined period. The last chart identifies the cost by category.
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The list below provides a description of the numbered items.
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1. This filter sorts the top 100 customers with the highest planned costs.
a. The drop-down enables you to select the fiscal year for which you want to see data.

b. Customers are sorted by the highest planned costs. The colors preceding the customer
identify the state of the plan:
Green indicates that the actual cost is within 100% of plan.
Yellow indicates that the actual cost is between 100 - 110% of plan.
Red indicates that the actual cost is over 110% of plan.

c. The drop-down option determines the order of the list. The default is to sort Customer by
Plan.
Customer by Plan lists the customers by the highest planned costs.
Customer by Variance lists the customers by those that are most over-plan within the top
100.
Customer by Name lists the customers alphabetically.

2. The YTD Plan Vs. Actual chart numerically displays the planned costs, actual costs, and the
difference between them. The progress bar shows a negative difference between the planned
and actual costs in red. A vertical scale lists the percentage of planned versus actual.

Actual costs within 100% of the plan are green.
Actual costs between 100 - 110% are yellow.
Actual costs over 110% are red.

a. The vertical progress bar shows the actual cost.

b. The costs for plan, actual, and available (difference between the two) are listed in
thousands.

c. The percent indicates the actual cost divided by the plan cost multiplied by 100.

3. The YTD Actual Cost by Supplier pie chart lists the top five suppliers with the largest actual
cost year-to-date.

a. The legend identifies the suppliers.

b. By placing the mouse pointer over the pie chart, you can view the cost and percent of total
spending. The "Other" label in the pie chart displays the percentage of actual costs for all
other suppliers who are not in the top five.

4. The YTD Discretionary pie chart lists your total discretionary and non-discretionary costs for
the year-to-date.

a. The legend identifies which section of the pie chart shows discretionary spending and
which part shows non-discretionary spending.

b. By placing the mouse pointer over the pie chart, you can view the percentage of
discretionary costs and non-discretionary costs for the year-to-date.

5. The YTD Actual Cost by Category pie chart displays the actual costs by cost category in
thousands.

a. The legend identifies the cost category.

b. By placing the mouse pointer over the pie chart, you can view the allocation of the actual
cost by category and identify where the highest actual costs occur. The "Other" label in the
pie chart displays the percentage of actual costs for all other cost categories.

Tier 2
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The data in this tier enables you to view the monthly, quarterly, and yearly planned costs of the
customer you selected in Tier 1.

The Monthly Plan Vs. Actual chart initially displays the cost in months, starting with the first month
of the fiscal year. You have the option to display the information quarterly. The chart can help
answer these business questions:

o How well is the customer staying within the plan on a monthly and quarterly basis?
o When did actual spending exceed the plan?

The Historical Cumulative Actual/Year's Total Plan chart provides historical monthly and quarterly
data for the current year and two previous years. The chart can help answer this business question:

o How well is the customer staying within the plan based on historical spending of the plan?
Example

This example has two charts that interact with Tier 1. The first chart shows the monthly and
quarterly plan. The second chart provides historical spending based on the current year and
previous two years.
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The list below provides a description of the numbered items.

1. The Plan Vs. Actual chart displays monthly or quarterly planned and actual costs for a fiscal
year. The vertical bar indicates what was planned and the blue diamond indicates what was
spent. You can select the vertical bar to drill down into the programs, business service,
supplier, or cost category details for that month or quarter in Tier 3. The selected bar is named
in the chart's subtitle. In the previous example, the selected baris FY2009/03. It is darker than
the other vertical bars. You can select the View by Month or View by Quarter option to switch
the display between months and quarters.

Note: If a planned cost amount for a period is significantly less than the planned or actual cost
amounts for other periods, the chart may not display a gray bar for the period or periods with the
lower planned cost amounts.

a. The highest amount on the vertical axis represents the maximum amount planned or spent
for a month or quarter within the current year.

b. The legend identifies the costs:
Planned amount: Square
Actual amount spent: Diamond

2. Historical Cumulative Actual/Year’s Total Plan provides a charting of percentage of actual
spend over time. Current year, plus the previous two years are charted, when data is available.
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The percentage is the cumulative amount spent divided by the entire year's amount planned
times 100. For example, if the actual spent for January was 10 and 100 was planned, the
percentage will be 10%. If the actual spent in February was 15, the percentage displayed will
be 25% (the sum of January and February divided by the year's planned amount). If 120 was
spent over the year and 100 was planned, the percentage displayed will be 120%. Note that no
icon will appear on the chart if data does not exist for that period.

a. The highest amount on the vertical axis represents the maximum percentage of the plan
used for a month or quarter period within the current year and previous two years.

b. The legend identifies the year of the month or quarter:
Current year: X
Previous year: Circle
Two years ago: Triangle

Tier 3

The four tabs on this tier enable you to view actual and plan costs for the selected customer for

Programs, Business Service, Supplier, and Cost Category. The information can help answer these
business questions:

o Where is the customer spending?
o Where does actual cost exceed the plan?

o What is the state of this customer's programs, business services, suppliers, and cost
categories?

Example

This example shows the details for the month or quarter selected in the Plan Vs. Actual chart from
Tier 2. The same information is displayed in a bar chart and in a table. The chart displays actual and
plan costs for an Unknown cost category in January. The table lists the actual and plan costs.

1 2
ﬂ,; . ppier | _, Murw/ —

a b a b
The list below provides a description of the numbered items.

1. The bar chart displays actual and plan costs for the selected customer in four areas: Program,
Business Service, Supplier, and Cost Category. Each area is a separate tab.
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a. The horizontal bars display the actual and plan costs for the selected Programs, Business
Service, Supplier, or Cost Category.

b. The legend identifies the costs:
Actual costs: Blue
Plan costs: Gold

2. Using data from the selected Programs, Business Service, Supplier, or Cost Category, the
table shows the details of plan versus actual for the selected customer.

a. The legend identifies the plan costs and the difference between actual and plan.
Actual costs within 100% of the plan are green.
Actual costs between 100 - 110% are yellow.
Actual costs over 110% are red.
Note: Xcelsius does not display an alert icon when the planned cost for a program,
business service, supplier, or cost category is zero.

b. The table lists the actual and plan costs for the selected programs, business service,
supplier, or cost category.

Tier Interaction

The interactive dashboard dynamically updates the charts when you choose a customer, change
the option to view monthly or quarterly costs, drill down to get more details, or select a Programs,
Business Service, Supplier, or Cost Category tab.
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The list below provides a description of the numbered items.
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1. The drop-down option enables you to display all or a subset of customers.
The drop-down enables you to select the fiscal year for which you want to see data.

By selecting a customer from this list, all charts in Tier 1, Tier 2, and Tier 3 will change.

> w0 N

By selecting the View by Month or View by Quarter option, all charts in Tier 2 and Tier 3 will
change.

o

By drilling down from this bar chart, Tier 3 charts will change.

6. By selecting the Programs, Business Service, Supplier, or Cost Category tab, the charts in
Tier 3 will change.

Financial Summary dashboard

The Financial Summary dashboard provides an organization’s CIO, IT Financial Manager, IT
Financial Analyst and IT Manager a view of how the organization is doing from the perspective of
staying within its defined financial Plan of Record (PoR).

The dashboard has three tiers containing financial components. The first tier displays a high level
view of the data. The second tier consists of monthly, quarterly, and yearly graphs of the data. The
third tier shows a table that provides a more detailed view of the data.

Tier 1

The YTD Plan Vs. Actual chart enables you to view your total IT planned versus actual costs for the
year-to-date. The chart can help answer these business questions:

o Is the organization staying within the PoR?
o How much does the organization have left in the PoR?

The YTD Actual Cost by Supplier pie chart enables you to view the top five suppliers by the highest
actual cost. The chart can help answer these business questions:

o Which top five suppliers are consuming the largest actual cost?
o What percent of the actual cost is for all other suppliers?

The YTD Discretionary table and pie chart enable you to view your total discretionary cost versus
non-discretionary cost for a fiscal period. The chart can help answer these business questions:

o Is the organization within its PoR for discretionary and non-discretionary expenses?
o What percentage of the actual cost is discretionary versus non-discretionary?

The YTD Capex Vs. Opex table and pie chart enable you to view your total capital expenditures
versus operating expenses for a fiscal period. The chart can help answer these business questions:

o Is the organization within its PoR for capital (Capex) and operating (Opex) expenses?
o What percentage of spending is capital expenses versus operating expenses?

o Where is the organization spending the majority of its actual expenses—on capital or operating
expenses?

Example
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The first chart identifies the planned and actual costs. The second chart displays the top five
suppliers with the highest actual cost. The third chart lists the total discretionary cost versus non-
discretionary cost for a defined fiscal period. The last chart lists the total capital expenses versus
operating expenses for a defined fiscal period.
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The list below provides a description of the numbered items.

1. The YTD Plan Vs. Actual chart numerically displays the planned costs, actual costs, and the
difference between them. The progress bar shows a negative difference between the planned
and actual costs in yellow. A vertical scale lists the percentage of planned versus actual.
Actual costs within 100% of the plan are green.

Actual costs between 100 — 110% are yellow.
Actual costs over 110% are red.

a. The drop-down enables you to select the fiscal year for which you want to see data.
b. The vertical progress bar shows the actual cost.

c. The costs for plan, actual, and available (difference between the two) are listed in
thousands.

d. The percent indicates the actual cost divided by the plan cost multiplied by 100.

2. The YTD Actual Cost by Supplier pie chart lists the top five suppliers with the largest actual
cost year-to-date.

a. The legend identifies the suppliers.

b. By placing the mouse pointer over the pie chart, you can view the cost and percent of total
spending. The "Other" label in the pie chart displays the percentage of actual costs for all
other remaining suppliers.

3. The YTD Discretionary table and pie chart list your total discretionary and non-discretionary
costs for the year-to-date.

a. Thetable lists the actual and plan costs for discretionary and non-discretionary spending.
Actual costs within 100% of the plan are green.
Actual costs between 100 - 110% are yellow.
Actual costs over 110% are red.

b. By placing the mouse pointer over the pie chart, you can view the percentage of actual
discretionary versus non-discretionary costs for the year-to-date.

4. The YTD Capex Vs. Opex table and pie chart list your total capital and operating expenses for
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the year-to-date.

a. Thetable lists the actual and plan costs for capital and operating expenses.
Actual costs within 100% of the plan are green.
Actual costs between 100 — 110% are yellow.
Actual costs over 110% are red.

b. By placing the mouse pointer over the pie chart, you can view the allocation of the actual
cost by capital versus operating expenses and identify where the highest actual costs
occur.

Tier 2

The data in this tier enables you to view the monthly, quarterly, and yearly planned costs. This tier
controls what data is displayed in Tier 3.

The Plan Vs. Actual chart initially displays the cost in months, starting with the first month of the
fiscal year. You have the option to display the information quarterly. The chart can help answer
these business questions:

o How well is the organization staying within the plan on a monthly and quarterly basis?
¢ When did actual spending exceed the plan?

The Historical Cumulative Actual/Year's Total Plan chart provides historical monthly and quarterly
data for the current year and two previous years. The chart can help answer this business question:

o How well is the organization staying within the PoR based on historical spending of the PoR?
Example

The first chart in this tier shows the monthly and quarterly plan. The second chart provides historical
spending based on the current year and previous two years.
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The list below provides a description of the numbered items.

1. The Plan vs Actual chart displays monthly or quarterly planned and actual costs for a fiscal
year. The vertical bar indicates what was planned and the blue diamond indicates what was
spent. You can select the vertical bar to display the region details for that month or quarter in
Tier 3. The selected bar is named in the chart's subtitle. In this example, the current period is
FY2009/03. It is darker than the other vertical bars. You can select the View by Month option to
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switch the display between months and quarters.

Note: If a planned cost amount for a period is significantly less than the planned or actual cost
amounts for other periods, the chart may not display a gray bar for the period or periods with the
lower planned cost amounts.

a. The highest amount on the vertical axis represents the maximum amount planned or spent
for a month or quarter within the current year.

b. The legend identifies the costs:
Planned amount: Square
Actual amount spent: Diamond

2. Historical Cumulative Actual/Year’s Total Plan provides a charting of percentage of actual
spend over time. Current year, plus the previous two years are charted, when data is available.
The percentage is the cumulative amount spent divided by the entire year's amount planned
times 100. For example, if the actual spent for January was 10 and 100 was planned, the
percentage will be 10%. If the actual spent in February was 15, the percentage displayed will
be 25% (the sum of January and February divided by the year's planned amount). If 120 was
spent over the year and 100 was planned, the percentage displayed will be 120%. Note that no
icon will appear on the chart if data does not exist for that period.

a. The highest amount on the vertical axis represents the maximum percentage of the plan
used for a month or quarter period within the current year and previous two years.

b. The legend identifies the year of the month or quarter:
Current year: X
Previous year: Circle
Two years ago: Triangle

Tier 3

The table in this tier dynamically changes based on the time period selected in the Plan Vs. Actual
chart from Tier 2. The information can help answer these business questions:

¢ Which regions are exceeding the plan?
o Which regions have historically exceeded their plans?
Example

This example shows the details by region for the month or quarter selected in the Plan Vs. Actual
chart from Tier 2. The table lists the actual and plan costs.
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The list below provides a description of the numbered items.
1. The default table displays actual and plan costs for each region for the current month.

a. The table shows the top eight regions for the current fiscal year. The Others column lists
the combined cost for all of the remaining regions. The table columns display the selected
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month’s or quarter's actual and plan costs for each region. Fewer than eight regions may
appear in the table if there are less than eight regions in total or if one or more of the top
eight regions does not have costs for that month.

The table displays actual and plan costs for each region, with totals for the selected month
or quarter. Current and previous year values are shown with available data. The total value
may be slightly different from a sum of the actual and plan costs since each cell is rounded

individually from the original costs.

Actual costs within 100% of the plan are green.
Actual costs between 100 — 110% are yellow.
Actual costs over 110% are red.

Tier Interaction
The interactive dashboard dynamically updates the charts when you choose the option to view
monthly or quarterly costs or drill down to get more details.
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The list below provides a description of the numbered items.
1. The drop-down enables you to select the fiscal year for which you want to see data.

2. By selecting the View by Month or View by Quarter option, Tier 2 and Tier 3 charts will be

updated.
By drilling down from this bar chart, the monthly or quarterly data will be updated in the Tier 3

table.
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IT Org dashboard

The IT Org dashboard provides an organization’s CIO, IT Financial Manager, IT Financial Analyst
and IT Manager a view of how organizations are doing from the perspective of staying within their
defined financial Plan of Record (PoR).

The dashboard has three tiers containing financial components. The first tier displays a high level
view of the data. The second tier consists of monthly, quarterly, and yearly graphs of the data. The
third tier shows tables that provide a more detailed view of the data.

Tier 1

The selection list in the first component displays the top 100 organizations. These organizations
can be sorted alphabetically by name, or sorted from highest to lowest by plan amount or by
variance amount. The metrics in the charts of this tier are based on the organization that is selected
from the first component.

The YTD Plan Vs. Actual chart enables you to view your total IT planned costs versus actual costs
for the year-to-date. The chart can help answer these business questions:

o Is the organization staying within the PoR?
e How much does the organization have left in the PoR?

The YTD Actual Cost by Supplier pie chart enables you to view the top five suppliers by the highest
actual cost. The chart can help answer these business questions:

o Which top five suppliers are consuming the largest actual cost?
o What percent of the actual cost is for all other suppliers?

The YTD Discretionary pie chart enables you to view your total discretionary cost versus non-
discretionary cost for the year-to-date. The chart can help answer this business question:

o What percentage of the actual cost is discretionary versus non-discretionary?

The YTD Actual Cost by Cost Category pie chart enables you to view the actual cost. The chart
can help answer these business questions:

« What is the allocation of the actual cost by category?

« Which top five categories account for the largest actual cost?
o What percent of the actual cost is for all other cost categories?
Example

This example shows the top 100 IT organizations that have the highest planned cost. The first chart
identifies the planned and actual costs. The second chart displays the top five suppliers with the
highest actual cost. The third chart lists the total discretionary cost versus non-discretionary cost
for a defined period. The last chart identifies the cost by category.
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The list below provides a description of the numbered items.

1. This filter sorts the top 100 IT organizations with the highest planned costs.

a.

b.

The drop-down enables you to select the fiscal year for which you want to see data.

Organizations are sorted by the highest planned costs. The colors preceding the
organization identify the state of the plan:

Green indicates that the actual cost is within 100% of plan.

Yellow indicates that the actual cost is between 100 - 110% of plan.

Red indicates that the actual cost is over 110% of plan.

The drop-down option determines the order of the list. The default is Organization by Plan.
Organization by Plan lists the organizations by the highest budgeted costs.
Organization by Variance lists the organizations by those that are most over-budget.
Organization by Name lists the organizations alphabetically.

2. The YTD Plan Vs. Actual chart numerically displays the planned costs, actual costs, and the
difference between them. The progress bar is empty because there is no data for actual costs.
A vertical scale lists the percentage of planned versus actual.
Actual costs within 100% of the plan are green.
Actual costs between 100 - 110% are yellow.
Actual costs over 110% are red.

a.

b.

C.

The vertical progress bar shows the actual cost.

The costs for plan, actual, and available (difference between the two) are listed in
thousands.

The percent indicates the actual cost divided by the plan cost multiplied by 100.

3. The YTD Actual Cost by Supplier pie chart lists the top five suppliers with the largest actual
cost year-to-date.

a.

b.

The legend identifies the suppliers.

By placing the mouse pointer over the pie chart, you can view the cost and percent of total
spending. The "Other" label in the pie chart displays the percentage of actual costs for all
other suppliers not in the top five.

4. The YTD Discretionary pie chart lists your total discretionary and non-discretionary costs for
the year-to-date.

a.

The legend identifies which section of the pie chart shows discretionary spending and
which section shows non-discretionary spending.
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b. By placing the mouse pointer over the pie chart, you can view the percentage of
discretionary costs and non-discretionary costs for the year-to-date.

5. The YTD Actual Cost by Category pie chart displays the actual costs by cost category in
thousands.

a. The legend identifies the cost category.

b. By placing the mouse pointer over the pie chart, you can view the allocation of the actual
cost by category and identify where the highest actual costs occur. The "Other" label in the
pie chart displays the percentage of actual costs for all other cost categories.

Tier 2

The data in this tier enables you to view the monthly, quarterly, and yearly planned costs of the IT
organization you selected in Tier 1.

The Monthly Plan Vs. Actual chart initially displays the cost in months, starting with the first month
of the fiscal year. You have the option to display the information quarterly. The chart can help
answer these business questions:

« How well is the IT organization staying within the plan on a monthly and quarterly basis?
o When did actual spending exceed the plan?

The Historical Cumulative Actual/Year's Total Plan chart provides historical monthly and quarterly
data for the current year and two previous years. The chart can help answer this business question:

o How well is the organization staying within the budget based on historical spending of the plan?
Example

This example has two charts that interact with Tier 1. The first chart shows the monthly and
quarterly plan. The second chart provides historical spending based on the current year and
previous two years.
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The list below provides a description of the numbered items.

1. ThePlan Vs. Actual chart displays monthly or quarterly planned and actual costs for a fiscal
year. The vertical bar indicates what was planned and the blue diamond indicates what was
spent. This example has no data for actual costs, so the diamond does not appear. You can
select the vertical bar to drill down into the programs, business service, supplier, or cost
category details for that month or quarter in Tier 3. The selected bar is named in the chart's
subtitle. In this example, the selected bar is FY2009/12. It is darker than the other vertical bars.
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You can select the View by Month or View by Quarter option to switch the display between
months and quarters.

Note: If a planned cost amount for a period is significantly less than the planned or actual cost
amounts for other periods, the chart may not display a gray bar for the period or periods with the
lower planned cost amounts.

a. The highest amount on the vertical axis represents the maximum amount planned or spent
for a month or quarter within the current year.

b. The legend identifies the costs:
Planned amount: Square
Actual amount spent: Diamond

2. Historical Cumulative Actual/Year’s Total Plan provides a charting of percentage of actual
spend over time. Current year, plus the previous two years are charted, when data is available.
The percentage is the cumulative amount spent divided by the entire year's amount planned
times 100. For example, if the actual spent for January was 10 and 100 was planned, the
percentage will be 10%. If the actual spent in February was 15, the percentage displayed will
be 25% (the sum of January and February divided by the year's planned amount). If 120 was
spent over the year and 100 was planned, the percentage displayed will be 120%. Note that no
icon will appear on the chart if data does not exist for that period.

a. The highest amount on the vertical axis represents the maximum percentage of the plan
used for a month or quarter period within the current year and previous two years.

b. The legend identifies the year of the month or quarter:
Current year: X
Previous year: Circle
Two years ago: Triangle

Tier 3

The four tabs on this tier enable you to view actual and plan costs for the selected IT organization
for Programs, Business Service, Supplier, and Cost Category. The information can help answer
these business questions:

o Where is the IT organization spending?
o Where does actual cost exceed the plan?

o What is the state of this IT organization's programs, business services, suppliers, and cost
categories?

Example

This example shows the details for the month or quarter selected in the Plan Vs. Actual chart from
Tier 2. The same information is displayed in a bar chart and in a table. The chart displays actual and
plan costs for programs in January 2009. The table lists the actual and plan costs.
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The list below provides a description of the numbered items.

1. The bar chart displays actual and plan costs for the selected IT organization in four areas:
Programs, Business Service, Supplier, and Cost Category. Each area is a separate tab.

a. The horizontal bars display the actual and plan costs for the selected Programs, Business
Service, Supplier, or Cost Category. This example has no data for actual costs, so the blue
horizontal bar does not appear.

b. The legend identifies the costs:
Actual costs: Blue
Plan costs: Gold

2. Using data from the selected Programs, Business Service, Supplier, or Cost Category, the
table shows the details of plan versus actual for the selected IT organization.

a. The legend identifies the plan costs and the difference between actual and plan.
Actual costs within 100% of the plan are green.
Actual costs between 100 - 110% are yellow.
Actual costs over 110% are red.
Note: Xcelsius does not display an alert icon when the planned cost for a program,
business service, supplier, or cost category is zero.

b. The table lists actual and plan costs for programs, business services, suppliers, or cost
categories.

Tier Interaction

The interactive dashboard dynamically updates the charts when you choose an IT organization,
change the option to view monthly or quarterly costs, drill down to get more details, or select the
Programs, Business Service, Supplier, or Cost Category tab.
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The list below provides a description of the numbered items.

1. The drop-down option enables you to display all or a subset of IT organizations.

. The drop-down enables you to select the fiscal year for which you want to see data.

2
3. By selecting an IT organization from this list, all charts in Tier 1, Tier 2, and Tier 3 will change.
4

By selecting the View by Month or View by Quarter option, all charts in Tier 2 and Tier 3 will

change.

o

By drilling down from this bar chart, Tier 3 charts will change.

6. By selecting the Programs, Business Service, Supplier, or Cost Category tab, the charts in

Tier 3 will change.

Program dashboard

The Program dashboard provides an organization’s CIO, IT Financial Manager, IT Financial Analyst
and IT Manager a view of how programs are doing from the perspective of staying within their

defined financial Plan of Record (PoR).

The dashboard has three tiers containing financial components. The first tier displays a high level
view of the data. The second tier consists of monthly, quarterly, and yearly graphs of the data. The
third tier shows tables that provide a more detailed view of the data.

Tier 1
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The selecton list in the first component displays the top 100 programs. These programs can be
sorted alphabetically by name, or sorted from highest to lowest by plan amount or by variance
amount. The metrics in the charts of this tier are based on the program that is selected from the first
component.

The YTD Plan Vs. Actual chart enables you to view your total IT planned costs versus actual costs
for the year-to-date. The chart can help answer these business questions:

¢ Is the program staying within the PoR?
e How much does the program have left in the PoR?

The YTD Actual Cost by Supplier pie chart enables you to view the top five suppliers by the highest
actual cost. The chart can help answer this business question:

o Which top five suppliers are consuming the largest actual?
o What percent of the actual cost is for all other suppliers?

The YTD Discretionary pie chart enables you to view your total discretionary cost versus non-
discretionary cost for the year-to-date. The chart can help answer this business question:

o What percentage of the actual cost is discretionary versus non-discretionary?

The YTD Actual Cost by Cost Category pie chart enables you to view the actual cost. The chart
can help answer these business questions:

o What is the allocation of the actual cost by category?

« Which top five categories account for the largest actual cost?
o What percent of the actual cost is for all other cost categories?
Example

This example shows the top 100 programs that have the highest planned cost. The first chart
identifies the planned and actual costs. The second chart displays the top five suppliers with the
highest actual cost. The third chart lists the total discretionary cost versus non-discretionary cost
for a defined period. The last chart identifies the cost by category.
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The list below provides a description of the numbered items.
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1. This filter sorts the top 100 programs with the highest planned costs.
a. The drop-down enables you to select the fiscal year for which you want to see data.

b. Programs are sorted by the highest planned costs. The colors preceding the program
identify the state of the plan:
Green indicates that the actual cost is within 100% of plan.
Yellow indicates that the actual cost is between 100 - 110% of plan.
Red indicates that the actual cost is over 110% of plan.

c. The drop-down option determines the order of the list. The default is Program by Plan.
Program by Plan lists the programs by the highest planned costs.
Program by Variance lists the programs by those that are most over plan.
Program by Name lists the programs alphabetically.

2. The YTD Plan Vs. Actual chart numerically displays the planned costs, actual costs,and the
difference between them. The progress bar shows a negative difference between the planned
and actual costs in red. A vertical scale lists the percentage of planned versus actual.

Actual costs within 100% of the plan are green.
Actual costs between 100 - 110% are yellow.
Actual costs over 110% are red.

a. The vertical progress bar shows the actual cost.

b. The costs for plan, actual, and available (difference between the two) are listed in
thousands.

c. The percent indicates the actual cost divided by the plan cost multiplied by 100.

3. The YTD Actual Cost by Supplier pie chart lists the top five suppliers with the largest actual
cost year-to-date.

a. The legend identifies the suppliers.

b. By placing the mouse pointer over the pie chart, you can view the cost and percent of total
spending. The "Other" label in the pie chart displays the percentage of actual costs for all
other suppliers who are not in the top five.

4. The YTD Discretionary pie chart lists your total discretionary and non-discretionary costs for
the year-to-date.

a. and which part shows non-discretionary spending.

b. By placing the mouse pointer over the pie chart, you can view the percentage of
discretionary costs and non-discretionary costs for the year-to-date.

5. The YTD Actual Cost by Category pie chart displays the actual costs by cost category in
thousands.

a. The legend identifies the cost category.

b. By placing the mouse pointer over the pie chart, you can view the allocation of the actual
cost by category and identify where the highest actual costs occur. The "Other" label in the
pie chart displays the percentage of actual costs for all other cost categories.

Tier 2

The data in this tier enables you to view the monthly, quarterly, and yearly planned costs of the
program you selected in Tier 1.
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The Monthly Plan Vs. Actual chart initially displays the cost in months, starting with the first month
of the fiscal year. You have the option to display the information quarterly. The chart can help
answer these business questions:

o How well is the program staying within the plan on a monthly and quarterly basis?
o When did actual spending exceed the plan?

The Historical Cumulative Actual/Year's Total Plan chart provides historical monthly and quarterly
data for the current year and two previous years. The chart can help answer this business question:

o How well is the program staying within the plan based on historical spending of the plan?
Example

This example has two charts that interact with Tier 1. The first chart shows the monthly and
quarterly plan. The second chart provides historical spending based on the current year and
previous two years.
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The list below provides a description of the numbered items.

1. The Plan Vs. Actual chart displays monthly or quarterly planned and actual costs for a fiscal
year. The vertical bar indicates what was planned and the blue diamond indicates what was
spent. You can select the vertical bar to drill down into the organizations, business service,
supplier, or cost category details for that month or quarter in Tier 3. The selected bar is named
in the chart's subtitle. In the previous example, the selected baris FY09/03. It is darker than
the other vertical bars. You can select the View by Month or View by Quarter option to switch
the display between months and quarters.

Note: If a planned cost amount for a period is significantly less than the planned or actual cost
amounts for other periods, the chart may not display a gray bar for the period or periods with the
lower planned cost amounts.

a. The highest amount on the vertical axis represents the maximum amount planned or spent
for a month or quarter within the current year.

b. The legend identifies the costs:
Planned amount: Square
Actual amount spent: Diamond

2. Historical Cumulative Actual/Year’s Total Plan provides a charting of percentage of actual
spend over time. Current year, plus the previous two years are charted, when data is available.
The percentage is the cumulative amount spent divided by the entire year's amount planned
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times 100. For example, if the actual spent for January was 10 and 100 was planned, the
percentage will be 10%. If the actual spent in February was 15, the percentage displayed will
be 25% (the sum of January and February divided by the year's planned amount). If 120 was
spent over the year and 100 was planned, the percentage displayed will be 120%. Note that no
icon will appear on the chart if data does not exist for that period.

a. The highest amount on the vertical axis represents the maximum percentage of the plan
used for a month or quarter period within the current year and previous two years.

b. The legend identifies the year of the month or quarter:
Current year: X
Previous year: Circle
Two years ago: Triangle

Tier 3

The four tabs on this tier enable you to view actual and plan costs for the selected program for
Organizations, Business Service, Supplier, and Cost Category. The information can help answer
these business questions:

¢ Where is the program spending?
o Where does actual cost exceed the plan?

« What is the state of this program's organizations, business services, suppliers, and cost
categories?

Example

This example shows the details for the month or quarter selected in the Plan Vs. Actual chart from
Tier 2. The same information is displayed in a bar chart and in a table. The chart displays actual and
plan costs for an Unknown organization in January 2009. The table lists the actual and plan costs.

1

Far Progeam four in Jan

E — e
A Corpoentn [T 79.950.99

W Actusl
B Pan

a b a b

The list below provides a description of the numbered items.

1. The bar chart displays actual and plan costs for the selected program in four areas:
Organizations, Business Service, Supplier, and Cost Category. Each area is a separate tab.
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a. The horizontal bars display the actual and plan costs for the selected Organizations,
Business Service, Supplier, or Cost Category.

b. The legend identifies the costs:
Actual costs: Blue
Plan costs: Gold

2. Using data from the selected Organizations, Business Service, Supplier, or Cost Category, the
table shows the details of plan versus actual for the selected program.

a. The legend identifies the plan costs and the difference between actual and plan.
Actual costs within 100% of the plan are green.
Actual costs between 100 - 110% are yellow.
Actual costs over 110% are red.
Note: Xcelsius does not display an alert icon when the planned cost for a program,
business service, supplier, or cost category is zero.

b. The table lists the organizations, business services, suppliers, or cost categories.

Tier Interaction

The interactive dashboard dynamically updates the charts when you choose a program, change the
option to view monthly or quarterly costs, drill down to get more details, or select the Organizations,
Business Service, Supplier, or Cost Category tab.
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The list below provides a description of the numbered items.
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—_

The drop-down option enables you to display all or a subset of programs.
The drop-down enables you to select the fiscal year for which you want to see data.

By selecting a program from this list, all charts in Tier 1, Tier 2, and Tier 3 will change.

> w0 N

By selecting the View by Month or View by Quarter option, all Tier 2 and Tier 3 charts will
change.

o

By drilling down from this bar chart, Tier 3 charts will change.

6. By selecting the Organizations, Business Service, Supplier, or Cost Category tab, the charts
in Tier 3 will change.
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Reports

You can use the out-of-box Web Intelligence (Webi) reports to view daily updates on actual versus
planned performance. You can modify the analytics as necessary to support the specific cost
analysis needs of your organization. You can also perform ad hoc analysis of cost data to answer
less common questions, while knowing that the data you view is consistent across all users.

With Webi reports, you can take advantage of these features:

Feature Description

Drill Down

Drill lower in the hierarchy within the same analytic. For example,
drill down from the Year to examine data for a Quarter or drill down
from the Quarter to examine data for a Month.

Drill Up

Drill higher in the hierarchy within the same analytic. For example,
drill up from the Month to examine data for a Quarter or drill up from
the Quarter to examine data for a Year.

Filter

Specify the data that you want by using the Filter dialog. For
example, filter on Retail Customers for the Customer dimension.
You can filter on a block (Chart/Table) or at the report level.

Change Chart/Table
Type

Select the Chart/Table format you want, and then drag it onto the
chart you want to modify. Web Intelligence transforms the
chart/table on the report to the new chart/table type you selected and
re-allocates the data to different chart axes/ Table disposition, if
necessary.

Format Charts

Right-click the chart and select Format > Chart. The Format Chart
dialog box appears. Select a tab (such as General or Appearance)
and change the formats.

Duplicate a Chart

Select the chart you want to duplicate. Click Duplicate on the
Report toolbar, or click the arrow next to the Duplicate button and
then select where you want the duplicate chart to be positioned in
relation to the original chart. Web Intelligence inserts the duplicate
chart.

Add/Replace Object to
the Table

Select the object you want to add and drag it over to the table so that
ared bar appears where you want to place the object. Release the
object.

For more information about using Webi reports, refer to the SAP® Business Objects
documentation available at the SAP Help Portal (http://help.sap.com) web site.

To use reports
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1. From the main menu bar, click Reports.

2. Select the report.

Bill of IT

Use the Bill of IT analytic to view cost statement summary reports at the customer level. When you
select the report, you will be prompted for the Customer Name.

The analytic can help answer business questions such as these:

o What are the top 10 business services with the highest actual cost?

« What are the actual cost, planned cost, and variance from plan by business service?

o What percent of the actual cost is the business service consuming?

The table below lists details for Bill of IT:

Category Description

Usage Users CFO
Frequency Current year-to-date

Layout | Dimensions Business Service Name, Customer

details Name
Measures Actual Cost, Planned Cost, Variance

from Plan

Drill None

options

Type Web Intelligence Report (Webi)

Format Pie chart and table

Universe | Bill of IT

Notes This analytic has a pie chart and a table. The pie chart displays the percentage of the
actual cost by the customer's top 10 business services. The table displays the
business service name, actual cost, planned cost, and variance (actual cost -
planned). Actual costs that exceed planned costs are highlighted in red.

Multi-Dimensional Cost Comparison Analysis

Use the Multiple Dimensional Cost Comparison Analysis analytic to compare how the organization
is doing by these dimensions:

o Customer

e Business Service

¢ IT Organization
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e Location

e Suppliers

Each dimension has its own tab where you can view the cost variance amount, planned cost, cost
variance percentage, and actual cost.

The analytic can help answer business questions such as these:

What are the top 10 dimensions with high cost variance amounts for the month or quarter?

What are the top 10 dimensions with the highest planned cost for the month or quarter?

What are the top 10 dimensions with high cost variance percentages for the month or quarter?

What are the top 10 dimensions with the highest actual cost for the month or quarter?

The table below lists details for Multiple Dimensional Cost Comparison Analysis:

Category Description

Usage Users CIO, IT Financial Manager, IT Financial
Analyst, IT Manager
Frequency Monthly, quarterly, or yearly; the default
is quarterly
Layout | Dimensions Customer, Business Service,
details Organization, Location, Supplier
Measures Cost Variance Amount, Cost Variance
Percentage, Planned Cost, Actual Cost
Drill Drill down from a quarter to a month
options Drill up from a quarter to a fiscal year
Type Web Intelligence Report (Webi)
Format | Barchart and table
Universe | IT Financial Analysis
Notes This analytic has five tabs: Customer, Business Service, Organization, Location,

Supplier. Each tab displays the data in a bar chart and a table measured by four facts:
Variance Amount, Planned Cost, Variance Percentage, and Actual Cost.

Service Decomposition by Cl Type

Use the Service Decomposition by Cl Type analytic to view service cost decompositions by
configuration item.

The analytic can help answer business questions such as these:

« What are the top 10 configuration item types with the highest actual cost?

o What are the actual cost, planned cost, and variance from plan by configuration item?
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« What is my average cost for computers across all business services and cost categories?
o What percent of my actual costs is for servers?

The table below lists details for Service Decomposition by Cl Type:

Category Description

Usage Users IT Financial Manager

Frequency Current year-to-date
Layout Dimensions Business Service Name, Cost Category
details Name, Cl Type

Measures % of Cost, Cl Quantity, Actual Cost,

Average Cost, Average Cost by Cl Type

Prompts Business Service Name, Cost Category,
Fiscal Year

Drill Drill down from CI Type to Cl Model details
options

Type Web Intelligence Report (Webi)

Format Pie chart and table

Universe | Bill of IT

Notes This analytic has a pie chart and a table. The pie chart displays the percent of Actual
Cost by Top 10 CI Types for the selected Business Service-Cost Category. The
table displays the % of Cost, Cl Type, Actual Cost, Cl Quantity, Average Cost, and
Average Cost by Cl Type. Selecting the link on Cl Type refreshes the Service
Decomposition by Cl Type Detail report for the selected business service, cost
category, Cl type, and fiscal year.

In the Total Amounts row, the Avg Cost by CI Type field shows the average cost of
all Cls of any type across the entire data warehouse without filters. This amount may
include types that do not appear in the report because they do not match the business
service and cost category filters. The calculation for the Avg Cost by Cl Type field in
the rows below the Total Amount row is the average cost of all Cls of this Cl type
across the entire data warehouse without filters.

Service Decomposition by Cost Category

Use the Service Decomposition by Cost Category analytic to view service cost decompositions by
cost category.

The analytic can help answer business questions such as these:
o What are the top 10 cost categories with the highest actual cost?

o What are the actual cost, planned cost, and variance from plan by cost category?
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« What is my average cost for computers across all business services and cost categories?

The table below lists details for Service Decomposition by Cost Category:

Category Description

Usage Users IT Financial Manager

Frequency Current year-to-date
Layout Dimensions Business Service, Cost Category
details

Measures % of Cost, Actual Cost, Planned Cost,

Variance from Plan

Prompts Business Service Name, Fiscal Year

Drill Drill through from Cost Category Name to Cl Types
options

Type Web Intelligence Report (Webi)

Format Pie chart and table

Universe | Bill of IT

Notes This analytic has a pie chart and a table. The pie chart displays the Variance of the
actual cost by the Top 10 Cost Categories for the selected Business Service. The
table displays the percent of cost, cost category, actual cost, planned cost, and
variance (actual - planned). Selecting the link on Cost Category refreshes the
Service Decomposition by Cl Type report for the current business service, selected
cost category, and fiscal year. The actual costs that exceed planned costs are
highlighted in red. Note that the actual amount will be larger than the amount shown
on the Service Decomposition by Cl Type report due to cost categories amounts with
no associated Cl type.

Service Decomposition by Cl Type Detail

Use the Service Decomposition by ClI Type Detail analytic to view service cost decompositions by
configuration item.

The analytic can help answer business questions such as these:

« What are the top 10 configuration item types with the highest actual cost?

o What are the actual cost, planned cost, and variance from plan by configuration item?

o What is my average cost for computers across all business services and cost categories?
o What percent of my actual costs is for servers?

The table below lists details for Service Decomposition by Cl Type:
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Category Description

Usage Users IT Financial Manager
Frequency Current year-to-date
Layout Dimensions Business Service Name, Cost Category
details Name, Cl Type, Cl Model Name,
Operating System, Processor, Memory
(RAM)
Measures % of Cost, CI Quantity, Actual Cost,
Average Cost, Average Cost by ClI
Prompts Business Service Name, Cost Category,
Cl Type, Fiscal Year

Drill None
options

Type Web Intelligence Report (Webi)

Format Pie chart and table

Universe | Bill of IT

Notes This analytic has a pie chart and a table. The pie chart displays the % of actual cost
by the models. The table displays the % of Cost, Model Name, Operating System,
Processor, RAM, Quantity, Actual Cost, Average Cost, and Average Cost by CI.
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Admin

The data warehouse delivers different types of reports in a SAP BusinessObjects Enterprise XI| 3.1
Web Intelligence format that report on administrative or Audit, Balance, and Control (ABC)
activities. If you have Administrator privileges, you can access the administrative or ABC reports
from this menu. You can also log in to the data warehouse to configure your ETL data sources. For
information about the administration reports and other data warehouse administration tasks, see the
IT Data Warehouse Administration Guide.
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Tools

You can use business intelligence tools to access, analyze, report, and share information about
your organization. The BusinessObjects Information Portal enables you to view your inbox,
favorites, and document lists. For more information about using InfoView, refer to the SAP®
Business Objects documentation available at the SAP Help Portal (http://help.sap.com)web site.

Information Portal

The Information Portal is a direct link to your installation of SAP® BusinessObjects Enterprise XI.
SAP® BusinessObjects Enterprise Xl is a business intelligence application that enables you to
view, edit, and create analytics. You can:

¢ Add, maintain, store, and create database queries that generate analytics.
¢ Run queries at any time to refresh the data.

Note: Remember to enable popup windows from your browser when you access the Information
Portal. The link to SAP® BusinessObjects Enterprise X| automatically opens a new browser
window.

How do | create a Web Intelligence Report?

When you create a Web Intelligence Report using the SAP® BusinessObjects Enterprise XI
applications, you can design and run queries. You can view and format the report, then save it for
others in your organization.

Financial Planning and Analysis simplifies the query process with subject oriented views that
contain universe objects. The universe that you choose has relevant dimensions, measures, and
filters that are essential for your particular interest.

For more information, refer to the SAP® Business Objects documentation available at the SAP
Help Portal (http://help.sap.com) web site.

Use historical data in ad hoc queries

Financial Planning and Analysis enables you to modify Web Intelligence Reports to use historical
data instead of current data for ad hoc queries. You can use a snapshot of the data from the time the
records were created to make comparisons and do trend analysis. To modify a Web Intelligence
Report to use historical data, edit the report query to include the Show Historical Information
filter.

For more information, refer to the SAP® Business Objects documentation available at the SAP
Help Portal (http://help.sap.com) web site.
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How do | create an Xcelsius Flash report?

You can create Xcelsius Flash reports using the SAP® Business Objects Xcelsius application. You
must use the out-of-box Xcelsius report source files as templates when you create custom
Xcelsius reports. You can access the source files in the Xcelsius Source folder in the SAP®
Business Objects InfoView document list.

For more information, refer to the SAP® Business Objects documentation available at the SAP
Help Portal (http://help.sap.com) web site.

Print

You can print the current page of the Financial Planning and Analysis application.
1. From the main menu, click Tools > Print.
2. Click the Print icon in the upper left corner.
3. Inthe Print dialog box, select the printer.
4. Click Print.
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Chapter 9

Print documentation

You can access the online help directly, or you can print the documentation to review offline. Click

the Print icon to print a single topic or print the complete formatted version of the Financial Planning
and Analysis documentation.

To obtain the most current version of all Financial Planning and Analysis documentation, visit the
product manuals web site at: HP Software Product Manuals

This site requires that you register as an HP Passport user and sign in. To register for an HP
Passport ID, go to: HP Passport Registration.
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A

ABC

Audit, Balance, and Control (ABC). ABC
is an application that triggers the ETL
processes. Audit ensures consistency
during ETL processing. It measures the
number of records in and the number of
records out for each step and displays
these runtime statistics in a collection of
audit reports. Balance verifies that datain
the data warehouse matches data in the
source system. For example, if the data
warehouse stores project dollar amounts
then the balance process verifies that the
aggregate project dollars in the data
warehouse matches the aggregate
project dollars in the source application
data. Control governs ETL processes.
Control makes sure that there is a proper
restart and recovery when a system error
occurs. Control also manages job
dependencies at runtime.

ABC Batch

An instantiated ABC job stream built from
the job stream definition. The execution is
sequential: one batch must finish
execution before a new batch for the
same job stream can start. In the case
where there is both upstream and
downstream ETL, an upstream batch and
a downstream batch can run
concurrently. Each executable batch has
aunique ID.

ABC Job stream

A flow of individual execution (job stream)
steps and a description of related
dependencies. A job stream can have
one or more start steps, one or more end

steps, and execute several parallel
branches. A stream ID value identifies
the individual stream. The ABC job
stream contains one-to-many job stream
steps.

ABC Job stream step

An individual step that invokes a
command line utility or executes an SAP
BusinessObjects Data Services job. An
ABC job stream step is unique within an
ABC job stream.

ad hoc query

A spontaneous request for information
that is formulated and run a single time.

aggregation

The accumulation of related data into a
pre-joined table.

allocation engine

The allocation engine is a process that
communicates with the (FPA) web
application. It provides status information
about allocations when changes are
made to stages orrules. It selects costs,
updates relationships, and splits costs
across the data model. By using
allocation scenarios, stages, and rules,
financial analysts can allocate the costs
to compare planned versus actual costs
and use the results for proper cost and
budget management.

allocation scenario

An allocation scenario is a tool that
enables you to analyze planned costs
and actual costs by categorizing them.
You can use categorized costs to
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compare planned (budgeted) costs to the is much broader, potentially
actual costs. encompassing knowledge management,
enterprise resource planning, data

allocation stage mining, and other practices.

Allocation stages are a required
component of the allocation engine. They
identify a dimension that is associated
with a Cost fact table. You can define
Actual Cost and Planned Cost stages.

business process

A set of business services that support a
single corporate purpose.

business service

analytic application . . .
A business service is the combination of

one or more business applications plus
the supporting configuration items that
enable delivery of the business service to
the customer. The products that IT offers
its customers are internal and external

A repor[ that summarizes or aggregates business services. A business service
data. supports zero-to-many organizations, and
a business service incident usually
impacts associated organizations. An
organization can rely on one-to-many
business services; however, an incident
that affects the organization may not
always affect the associated business

B service. Enterprise resource planning
(ERP) is a good example of a business
service. ERP is a business management

An application that produces a series of
interactive reports that support
management decisions.

analytics

assignment group

A list of users who are responsible for an
incident.

backfill record

A snapshot from the source system used
to complete partial data entities in the
change data capture (CDC) records for a
given cycle.

business driver

The tasks, information, people, and
requirements that promote and support
the goals of the enterprise.

business intelligence

The result of in-depth analysis of
business data.

business intelligence analysis

system that integrates all facets of the
business, including planning,
manufacturing, sales, and marketing.

There can be many component business

applications such as inventory control,
order tracking, customer service, finance,
and human resources.

CapEx

Capital expenditure. Funds used to buy or
upgrade physical assets such as the
purchase of property or equipment.

Business intelligence describes the result catalog

of in-depth analysis of detailed business A list of declared available executables.

data, including database and application
technologies and analysis practices.
Business intelligence is sometimes used
synonymously with decision support but
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change data capture

FPA uses the change data capture
(CDC) technique to detect inserts and
updates from source data based on the
previously extracted change timestamp
for each entity. Delete records are
detected using a full key compare against
the Transactional Snapshot (TSNP).

composite key

A primary key that consists of more than
one column.

configuration item

A component of infrastructure such as a
hardware component in a larger hardware
system, a software application, or any
other identifiable item that supports a
business service.

Configuration Management Database

A well-designed Configuration
Management Database (CMDB) is a
critical building block that stores
configuration, asset, and incident data.
The CMDB integrates information about
assets, incidents, problems, change
requests, and configuration items (Cls).

conformed dimension

A standardized enterprise-wide definition
of a dimension.

consolidated model

During the ETL process, FPA gathers
information from one or more source
systems and conforms the data into a
single consolidated entity before loading
it into the data warehouse.

core model

In the core model, data marts are
architected to share the same master set
of conformed dimensions and
standardized facts across the enterprise.

corporate information factory

The framework that surrounds the data
warehouse.

cost variance

The difference between the planned cost
and the actual cost of a project.

CSNP

Consolidated Snapshot.

cube

A multi-dimensional structure that
contains an aggregate value at each
point. The edges of the cube contain the
dimension members, and the body
contains the data values.

dashboard

A reporting tool that consolidates,
aggregates, and arranges measurements
and metrics on a single screen so
information can be monitored at-a-glance.

data architecture

The data, processes, and technologies
that an enterprise uses to create and
operate information systems.

data flow

A reusable object that contains steps to
define the transformation of data from
source to target.

data integration

The activity of combining data from
multiple data sources to present a single
collection of data to the warehouse.

data mart

A highly-focused version of a data
warehouse that contains data for a
specific subject area.
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data model

Data models describe the source,
extraction, consolidation, and target
components for a single entity.

data quality

The degree of data excellence. The data
should be timely, well understood, and
satisfy the needs of the business.

data warehouse

A repository of integrated information that
is available for queries and analysis.

dimension

An entity that describes, qualifies, or
otherwise adds meaning to the
measurements (facts) that business
users want to analyze.

discretionary

Discretionary expenditure or managed
cost. Nonessential costs such as
advertising, maintenance, or research
and development that may be eliminated
without disrupting operations.

drill down

In reports, you can click the magnifying
glass icon on the right of the standard
toolbar to start drill mode. Items in the
analytic become clickable and enable you
to drill lower in the hierarchy within the
same analytic. For example, drill down
from the year to examine data for a
quarter.

drill through

In reports, you can click a data point in
the chart or other link to get more
information from a child analytic. Drill
through analytics are Details analytics.

drill up

In reports, you can click the magnifying
glass icon on the right of the standard
toolbar to start drill mode. Items in the

analytic become clickable and enable you
to drill higher in the hierarchy within the
same analytic. For example, drill up from
the month to examine data for a quarter.

E

efficiency and effectiveness

Efficiency describes how well IT meets
customer expectation with minimal
resources, expense, or unnecessary
effort. Effectiveness measures the
degree of success in achieving a given
goal. Unlike efficiency, effectiveness
does not measure the resources
expended, the expense incurred, or the
effort, but only the degree of success. IT
can be effective without being efficient.
FPA enables you to construct scenarios
that alter resources, expenses, or other
efficiency components to improve
effectiveness.

enterprise key

The enterprise key is used to generate
the durable key in the target entities.

ETL

The Extract, Transform, and Load (ETL)
process is an end-to-end transfer of
external source data through several
staging layers and into the target layer of
the data warehouse. The source data can
reside in a single database or multiple
databases. The data warehouse uses the
ETL process to extract, consolidate, and
transform the source datainto a
meaningful target model that populates
relevant business analytics.

executable

A program that executes an ETL task:
Any custom script or program that
complies with the data warehouse ABC
API. An SAP BusinessObjects Data
Services job that complies with the data
warehouse ABC utilities.
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EXT
Extract Staging.
external key

A string used to identify an object in an
external store such as arecord in a
database.

Extract (ETL)

The extract process extracts delta data
from the source systems and writes it to
delimited flat files on the file system. The
data warehouse uses the Change Data
Capture (CDC) technique for extracting
data from the source tables. FPA
extracts data if the last modification date
is greater than or equal to the maximum
last modification date value.

F

fact

The central table in a star schema that
contains the measures that the business
users want to analyze.

foreign key

A field in a table that links to another
related table.

G

H

hierarchy

A logical structure that uses ordered
levels as a means of organizing data.

historical data

Data from previous time periods that is
used for trend analysis and comparisons.

L

Load (ETL)

The load process adds new records,
updates existing records, and flags
deleted records in the data warehouse
target layer fact and dimension tables.

log

A log displays an alert that an issue
occurred during execution. The
information in the execution log can
become an alert when configured by the
alert system.

governance

A process or group used to control
change and provide oversight.

granularity

The level of the measures within a fact
table represented by the lowest level of
the dimensions.

measure

A value collected by the executable
during execution, such as the number of
rows processed during an ETL job, or an
amount extracted from a table that
describes expenses in a source
application. The ABC application does
not make any assumptions about the
business tasks performed by the
executable orimpose any semantic
requirements on computed measure
values. The ABC application provides an
interface for the executable to store
measures. The ABC reports provide drill-
down capabilities into the stored
measures.
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merge

Tables that exist across multiple data
sources and where reconciliation is done
are consolidated with amerge. Ina
merge, all records from all tables are
imported, and reconciliation is done
where appropriate. Merges join tables
where they overlap and also import all
other records.

metadata

Agreed-upon definitions and business
rules stored in a centralized repository to
ensure that business users use common
terminology for key business terms.

metric

A framework to establish and collect
measurements of success or failure on a
regulated, timed basis that can be audited
and verified.

MSC

Multiple Source Consolidated.
MSI

Multiple Source Identity.
multi-dimensional

The aggregation of data by the
dimensions of the business. For
example, sales by region by product by
time.

N

near-real-time

Rapid updates from transactional
systems.

non-discretionary

Non-discretionary expenditure. Essential
costs that cannot be eliminated without
disrupting operations.

online analytical processing

OLAP. An application that allows multi-
dimensional manipulation, display, and
visualization of data.

operational data store

A database designed to integrate data
from multiple sources to make analysis
and reporting less complicated.

OpEx

Operational expenditure. The ongoing
cost for running a product, business, or
system, such as the cost of research and
development.

organization

Part of the business that provides a
product or service to an internal or
external customer.

primary key

Primary keys are the field or fields that
make up the unique value for each record.
In the source application, this is
represented by the business key. In the
data warehouse, it is the surrogate key.

prioritization

When the number of services required
exceeds your capacity, you must
establish rules to organize open incidents
into a work queue. The most urgent
incidents are at the beginning of the
queue; incidents with lower priority are at
the bottom of queue.

process

A process is an execution of a job stream
step in a specific batch. A single job
stream step may lead to multiple
processes in cases of retries.
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R

real-time
Instantaneous reporting.
reconciliation

Data reconciliation helps ensure the
quality of the data.

report

A pre-defined document that targets a
specific audience or user.

report library

A set of programs that have been
created, tested, quality assured,
documented, and made available to the
user community.

resource allocation

The challenge for IT is to reduce costs
without compromising services.
Reducing personnel can reduce costs,
but may seriously affect services that
require high service levels and minimal
outages. FPA enables you to plan for
resource needs, the cost of reducing
head count, and validate that resources
levels are correct for your service
requirements. For example, increased
revenues may mean increased demand
for services and more unplanned
outages. How much budget do you need
to assign enough technicians to cover
expected demand?

risk

The possibility of a measurable monetary
loss or an intangible opportunity cost.

S

slowly changing dimension

A slowly changing dimension (SCD)is a
dimension that contains data that
changes overtime. For SCD type 1

changes, the new data overwrites the
original data. For SCD type 2 changes a
new record is generated. FPA makes a
copy of the record and flags the original
record as historical. Both the new and old
record share the same durable key,
indicating that they are the same piece of
data.

snowflake schema

A type of star schema in which the
dimension tables are partly or fully
normalized.

Ssi

Single Source Identity.
SSNP

Single Source Snapshot.
staging

A collection area where data is
transformed for presentation, integration,
or enhancement.

star schema

A relational schema whose design
represents a dimensional data model.

star schemas

A relational schema whose design
represents a dimensional data model.

stream step detail

A sub-task of the executable job stream
step. There are no assumptions about the
content of the executable; therefore, the
stream step detail is not modeled. The
ETL designer is responsible to define the
job stream step details.

surrogate key

A surrogate key is a primary key for the
dimension tables. It is the field that
makes up the unique value for each
record in the data warehouse. Surrogate
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keys are numeric and are controlled by
the ETL process. X

XFR

T

Dimensional Transform.

Transform (ETL) XREF

During the transformation process, FPA
transforms data into the format of the
target tables and populates the load-
ready target staging tables. The
Transformation layer contains load-ready
tables that match the internal structure of
the data warehouse target tables.

Cross Reference.

TSNP

Transactional Snapshot.

U

union

Tables that occur in either single or
multiple data sources and have records
that are assumed to be equal and
independent are consolidated with a
union. In a union, all records from all
sources are imported but are not
reconciled. They are simply added to the
rowset.

universe

Contains dimension and measurement
objects that map to structures in the
database. Analytics use data in the
universe.

upstream

Upstream ETL retrieves data from one or
more external applications, consolidates
it into a target data model, and stores it in
the data warehouse.

w

work flow

A reusable object containing steps to
define the order of job execution.

Page 100 of 100 HP Financial Planning and Analysis (9.20)



	Application User Guide
	Contents
	Financial Planning and Analysis
	Features
	Financial Planning and Analysis architecture

	What's new?
	IT Executive Scorecard and Financial Planning and Analysis portfolio compatib...
	Budgets
	Dashboards
	Installation and configuration
	Reports

	Working With Financial Planning and Analysis
	What is Financial Planning and Analysis?
	Allocations
	Assumptions
	Cost data model
	Dashboards
	FPA data
	Prerequisites
	Reports
	Security roles


	Allocations
	Cost allocation
	Budget allocation
	Metric based allocation
	Allocation engine
	1: Define allocation scenarios
	Allocation scenario
	How do I add an allocation scenario?
	How do I copy an allocation scenario?
	How do I delete an allocation scenario?
	How do I filter a list of allocation scenarios?
	How do I update an allocation scenario?
	How do I view an allocation scenario?
	How do I add an allocation stage to a scenario?
	How do I delete an allocation stage from a scenario?

	2: Define allocation stages
	Allocation stage
	How do I add an allocation stage?
	How do I delete an allocation stage?
	How do I reorder allocation stages in a scenario?
	How do I update an allocation stage?
	How do I view a list of allocation stages?
	How do I add an allocation rule to an allocation stage?
	How do I delete an allocation rule from an allocation stage?

	3: Define allocation rules
	Allocation rule
	How do I add an allocation rule?
	How do I add Cost Source and Cost Target criteria?
	To add Cost Source criteria
	To add Cost Target criteria

	How do I delete an allocation rule?
	How do I reorder allocation rules in a stage?
	How do I update an allocation rule?
	How do I view an allocation rule?

	4: View Cost Explorer
	Cost Explorer
	Configuration
	Measures
	How do I add a configuration?
	How do I delete a configuration?
	How do I email a configuration link?
	How do I update a configuration?
	How do I view Cost Explorer?
	How do I view another configuration of the scenario?
	How do I update a view of cost measures?
	How do I sort charts?
	How do I add a filter in Cost Explorer?

	5: Publish results
	How do I publish results?
	How do I unpublish results?


	Budgeting
	Budgeting workflow
	How do I create and define a budget?
	How do I copy a consolidated budget?
	How do I update a budget definition?
	How do I finalize a budget definition?
	How do I notify cost center managers to ask for their budget data?
	How do I enter budget data?
	How do I mark a cost center budget complete?
	How do I review and accept or reject completed cost center budgets?
	How do I accept the consolidated budget?
	How do I publish the consolidated budget?
	How do I view the consolidated budget?

	Dashboards
	Business Service dashboard
	Customer dashboard
	Financial Summary dashboard
	IT Org dashboard
	Program dashboard

	Reports
	Bill of IT
	Multi-Dimensional Cost Comparison Analysis
	Service Decomposition by CI Type
	Service Decomposition by Cost Category
	Service Decomposition by CI Type Detail

	Admin
	Tools
	Information Portal
	How do I create a Web Intelligence Report?
	Use historical data in ad hoc queries
	How do I create an Xcelsius Flash report?

	Print

	Print documentation
	Glossary

